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Gribnif Software Preface 

1. Preface 

1.1. Thank You 
All of us ac Gribnif Software would like co thank you for licensing chis copy of 

STalker™ 3. We have worked very hard co make ic what iris coday, and we hope char 
you appreciate rhe results. We wane you co know char we appreciate your support. 

1.2. Software Piracy 
A large amount of our rime and effort has gone in co making chis STalker 3 package 

possible. Therefore, we ask char you not give copies of chis program co your friends. 
Not only is this illegal, bur in rhe end it hurts nor just us, bur you. 

The loss of sales due co piracy will only make ic harder for us co develop new and 
exciting Atari software like STalker. We have many ideas for new Atari software devel­
opment, bur whether they come co pass depends on you and ocher Acari owners. Please, 
do not give out copies of our software! 

1.3. Copyright Notice 
The STalker 3 program is copyrighted by Strata Software, which is represented by 

Gribnif Software. Gribnif Software (hereby referred co as "we" or "us") also holds all 
ocher copyrights over rhe program documentation and packaging. We reserve all rights 
co and ownership of chis package, its disk, software, and documentation. Use of this 
software, disk, and manual are subject co rhe terms of rhe following licensing agreement. 

1.4. Licensing Agreement 
In agreeing to the terms of rhe licensing agreement for this STalker 3 package 

(which consists of the disk, the software on the disk, rhe documentation, and any other 
material contained in che package), you are licensing chis package for your own personal 
use for as long as you do nor violate chis licensing agreement. You may make backup 
copies . of che software for your own personal use and/or for archival srorage only. The 
STalker 3 software may only be used by a single person on one or more computers, or 
on a single machine by one or more persons. This package cannot be licensed co more 
chan one user ac a rime. Please contact us for special mulciple user and multiple ma­
chine licensing agreements. 
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Renting or lending this package or any portion of it , placing it on a BBS (Bulletin 
Board System), reproducing the package or any portion of it in any way which is not 
permitted under the first paragraph of this licensing agreement, and/or sharing the pack­
age or any portion of it with other people is not allowed and will result in the automatic 
termination of this licensing agreement. In other words, you are not allowed to distribute 
copies of this program or its documentation in any way to anyone. 

You should remember that distribution of copies of this program and/or its docu­
mentation without proper permission violates federal and international copyright laws, 
and we will prosecute illegal users to the full extent of the law. 

To conform to the terms of this licensing agreement, you agree to correctly fill out 
and mail the enclosed STalker 3 Warranty/Upgrade Card. We must have this card on 
file before we can supply you with any technical support for STalker 3. 

You also agree to correctly register the STalker 3 program as instructed in this 
manual, and to correctly enter your name and address. Once this copy of STalker 3 is 
registered, you agree to destroy all non-registered copies of STalker 3 you may have. 
Keeping a non-registered copy of STalker 3 after registering a copy is a violation of this 
licensing agreement. 

If this licensing agreement is violated by you, you agree to mail to Gribnif Software 
your copy of the STalker 3 package (including all of irs contents), and destroy any copies 
you may have, paying all expenses. Notification of the violation is not required. Re­
member, STalker 3 is our property, you are simply licensing irs use. 

If you .violate this licensing agreement, you also agree to pay Gribnif Software for 
any damages that occur. It is your responsibility to uphold this licensing agreement. 

You also agree that you have read, understood, and agree to the Copyright Notice 
and Disclaimer Notice as they appear in this manual. 

1.4.1. If you DO NOT AGREE 

If you do not agree with the terms and conditions of this licensing agreement, do 
not unseal the disk envelope holding the program disk. Please return this STalker 3 
package to your place of purchase, or contact us directly. When you return the 
STalker 3 package, you must include all of the original documentation and packaging, 
and the disk envelope must still be sealed and unopened, and the program must not be 
registered. 

1.4.2. If you DO AGREE 

If you agree with the terms and conditions of this licensing agreement and you wish 
to use STalker 3 , open the disk envelope. Opening the disk envelope is considered an 
acceptance by you of all the stipulations presented in this licensing agreement. 

2 
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You also agree to correcdy fi ll out and mail the enclosed STalker 3 Warranty! 
Upgrade Card. We must have this card on file before we can supply you with any tech­
nical support for STalker 3 . 

You also agree to register STalker 3 using the procedure documented in this manu­
al, and to correcdy enter your name and address during this process. 

1.5. Disclaimer Notice 
Gribnif Software makes no warranties, either expressed or implied , with respect to 

this manual or the software described 'in this manual and supplied in the package, its 
qualiry, performance, merchantability, or fitness for any particular purpose. STalker 3 is 
licensed 'as is '. 

1.6. Defective Disks 
If the STalker 3 program disk is damaged or proves defective, you should contact us 

direcdy for a replacement. Do not return the damaged disk to the place of purchase, 
since they are not authorized to repair, replace, or swap it. 

1. 7. Upgrading STalker 
From time to time we may come out with new versions of STalker. You should 

contact us direcdy for upgrade information. Dealers are not authorized to upgrade the 
program. 

3 
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2. Introduction 

2.1. Program Overview 
STalker 3 is a full featured terminal emulator, complete with file transfer capabili­

ties. It fully supports the features that make your Atari so easy to use, including win­
dows, drop-down menus, and dialog boxes. And best of all, it operates as a desk 
accessory, so all of STalker 3's features are at your fingertips even when you are running 
other GEM programs! Of course, you can also run STalker 3 as a stand-alone program. 
Some important features of STalker 3 are: 

• Runs inside a GEM window with full GEM support 

• Operates as a desk accessory or a stand-alone program 

• Full background operation including file transfer- send or receive data while you 
use another GEM based program! 

• Cut and Paste, via Acari's text clipboard 

• YT-52, YT-100, and PC-ANSI emulation 

• ASCII, XModem, XModem I K, YModem, YModem-G, ZModem, and 
CompuServe B+ file transfers 

• Programmable Autodialer with up to 30 numbers 

• 20 user-definable function keys 

• Virtual screen size of 24-9999 lines by 40-200 columns 

• GDOS support for different terminal fonts and sizes 

• Support for NeoDesk® 3 and NeoDesk® 4 - Gribnif Software's desktop 
replacements 

• Fully integrated with STeno ™ - Gribnif Software's GEM based text editor 

• Includes Back TALK™- STalker's powerful scripting language 

4 
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2.2. About This Manual 
This manual tells you everything you need co know in order co operate STalker on 

any Acari compatible computer. Ahhough you will find STalker to be easy and intuitive 
to use, if you do not read the encire manual, you may miss out on a number of powerful 
features. 

If any changes or corrections have been made to the program or manual since the 
priming of this manual, you will find a file on the disk named READ_ME.NOW. Open 
chis file (double-dick on it from the deskcop, then follow the prompts) co display irs 
contents. Press the space bar co read the document screen by screen. You may also wish 
co princ this file for reference, since ir may concain important changes or additions co 
this manual and/or program. 

2.3. Problems and Support 
Gribnif Sofrware has tried very hard co make this sofrware package as free from de­

fects as possible. But, like all computer sofrware, it is never quite finished, so be sure co 
mail your warranty card co us so we can notify you of new versions of STalker as they 
become available. We must have your warranty card on file before we can make avail­
able to you any technical support or upgrades. 

If you have any problems with STalker please double check: 

• The READ_ME.NOW file on the STalker 3 program disk. 

• This manual. 

About 90% of the questions we receive are easily answered by looking in the manu­
al or READ_ME. NOW fi le. If, after a careful reading, you are still having problems, or 
have questions about STalker 3 not covered by the documentation, you can reach our 
technical support line at (413) 247-5620 during normal business hours (Eastern Stan­
dard Time). When you call, be sure to have your serial number handy. 

It is easier for us to answer your questions over the phone if you are in front of the 
computer and running STalker during the call. It is also helpful if you can duplicate the 
problem. 

You can also write co us at Attn: STalker Tech Support, Gribnif Software, P.O. 
Box 779, Northam peon, MA 0 I 061, U.S.A. , or you can send us a fax at (413) 
247-5622. We will try co answer as quickly as possible. 

5 
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If you write or fax, be sure to include a note with the following information : 

I. Your name. 

2. Your address. 

3. A daytime telephone number, if available. 

4. Your fax number, if applicable. 

5. Your STalker 3 serial number. 

6. Your STalker 3 program version (check under the STalker Info ... menu entry in the 
Atari "Fuji" Logo drop-down menu) . 

We are also available on the General Electric Network of Information Exchange 
(GEnie). You can contact us there under the Atari roundtable on page 475, category 
17. Electronic mail can be sent to our GRIBNIF address on GEnie. 

On CompuServe you can find us in the Atari Vendor area (GO ATARIVEN) under 
Gribnif Software, category 8. Electronic mail can be sent to our 75300,1131 address 
there. If you have access to the Internet you can send electronic mail to our 
CompuServe account at "75300.1131 @compuserve.com" 

As before, please include your STalker 3 serial number with any inquiries. 

6 
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3. Getting Started 

3.1. Registering and Backing Up the Disk 
Before you do anything else, you must register your original STalker 3 Master Disk 

so that it becomes operational. STalker 3 is not copy protected. Instead, we ask that 
you follow this simple registration procedure which will ask you for your legal name and 
address (needed in order for you to receive help or updated versions of STalker 3, and to 

conform with the terms and requirements of our licensing agreement) so that your copy 
of STalker 3 becomes fully operational. Remember, registering STalker 3 is part of the 
licensing agreement as stated in the previous pages. As with any contract, make sure you 
have read the licensing agreement, fully understand it, and agree with it. 

Follow these easy steps to register your copy of STalker 3. Do NOT write-protect 
the master disk or remove the disk during the procedure, because the registration pro­
gram needs to modify the contents of the disk. You must follow these instructions or 
STalker 3 will not work. 

I. Insert your original STalker 3 master disk into disk drive A and turn on your 
computer. 

2. You should see the REGISTER.PRG icon in an open window. If no window is 
visible, open a window to drive A and look for the REGISTER.PRG icon. 

3. Run the REGISTER.PRG program by opening it or double-clicking on it. 

4. Follow the on-screen instructions. At the prompt, enter your legal name and 
address. 

5. Wait a couple of seconds. The REGISTER.PRG will run and register your 
personal licensed copy of STalker 3. 

STalker 3 will NOT work if it has not been registered. The name and address you 
enter must match the information you filled out on the STalker 3 warranty card. If you 
move, please mail us a U.S. Post Office Change of Address Card or equivalent with your 
new address. Be sure to include your STalker 3 serial number. 

If your original STalker 3 master disk does not have a REGISTER.PRG program 
on it, you may have been sold a previously registered copy of STalker 3. Please contact 
us for a replacement, as nobody likes buying used software. 

7 



STalker 3 

After registering your copy of STalker, you should make a backup copy of the 
STalker program disk. Floppy disks are magnetic media and you never know what can 
happen to them. For this reason, we do not recommend using the original STalker pro­
gram disk for daily use. Instead, we STRONGLY recommend that you make a backup 
of the program disk and install STalker on your hard drive or regular boot disk. 

The desktop disk copy procedure, as documented in your desktop manual, will al­
low you to make a backup of the STalker program disk. 

3.2. Installing STalker 3 
As STalker is not copy protected, it can be copied to your regular boot disk or hard 

drive. When run as a stand-alone program, STalker can be stored in any folder or direc­
tory. When run as a desk accessory, it must be stored in the same directory where your 
other desk accessories are located. Be certain to copy the STALKER.RSC file into this 
directory, along with the STALKER.PRG or STALKER.RSC file, or STalker will be un­
able to run . 

Note: The STALKER.PRG and STALKER.ACC files are actually the same file . Just 
rename the file ending to change the way it works. 

If you find the previous explanation slightly confusing, the following installation 
procedure will simplify the process. 

3.2.1. To install as a desk accessory 

• Hard Drive users 

I . Place the STalker program disk in disk drive A. Then open a desktop window to 
drive A. 

2. Open a second window to the boot partition of your hard drive (usually drive C) . 
A boot partition is the partition from which all of your accessories normally load. 

3. Select and drag the STALKER.ACC and STALKER.RSC files from the STalker 
program disk window (the drive A window) to the hard drive window (the drive C 
window). This will copy the STalker program to your hard drive. 

Note: The end goal is to place STALKER.ACC and STALKER.RSC in the same 
directory as the rest of your desk accessories. 
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• Floppy Drive users 

1. If you presently do not have a boot disk, then format a new disk. This will become 
your boot disk. A boot disk is a disk that the computer uses when you turn it on w 
initialize itself and w load desk accessories. From now on, this disk should go in 
drive A whenever you turn on or reboot (reset) your computer. 

2. If you have a single drive system, place your boot disk in drive A. If you have a 
double drive system, place the boot disk in drive B. 

3. Open a window w drive B by double clicking on the drive B icon. If you have a 
single drive system, press the [Return] key at the prompt asking you to insert disk B 
inw drive A. From this point on, your boot disk is considered "Disk B". 

4. Place the STalker program disk in drive A. If you have a single drive system, 
remove your boot disk before inserting the STalker program disk. 

5. Open a window w drive A by double clicking on the drive A icon. If you have a 
single drive system, press the [Return] key at the prompt asking you w insert disk A 
inw drive A. From this point on, your STalker program disk is "Disk A" . 

6. You will now have rwo windows open, one labeled "A" and the ocher labeled "B" . 
Drag the STALKER.ACC file and the STALKER.RSC file from the "A" window 
(the STalker program disk window) over w the "B" window (the boot disk 
window). This will copy the STalker program to your boot disk. 

Note: If you have a single drive system, the operating system will ask you for a series of 
disk swaps. These messages will prompt you at different times w insert disk A 
(the STalker program disk) or disk B (your boot disk) inw drive A. Carefully 
follow these prompts and be certain w insert the correct disk so chat all the 
STalker files are copied correctly. 

3.2.2. To install as a GEM program 

• Hard Drive users 

I. Place the STalker program disk in disk drive A. Then open a desktop window w 
drive A by double-clicking on the drive A icon. 

2. Open a second window w your hard drive. It does not matter which hard drive 
partition (letter) you choose, since you can place the STalker program anywhere. 

3. Create a new folder with the name STALKER on the hard drive. This is done from 
the deskwp by selecting Create Folder .. . or New Folder .. . from the File drop-down 
menu. 

4. Open the hard drive window to the newly created STALKER folder by clicking on 
the STALKER folder icon within the hard drive window. 
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5. Selecc and drag che STALKER.PRG and STALKER.RSC files from che STalker 
program disk window (che drive A window) co che hard drive window. This will 
copy che STalker program co your hard drive. 

Noce: The end goal is co place STALKER.PRG and STALKER.RSC in che STALKER 
folder you creaced in your hard drive. 

• Floppy Drive users 

I. Selecc che disk you wish co place che STalker program on. If you do nor have 
enough space on any of your disks, chen formac a new disk. This will be known as 
che "new STalker disk" . 

2. If you have a single drive syscem, place che new STalker disk in drive A. If you have 
a double drive syscem, place che new STalker disk in drive B. 

3. Open a window co drive 8 by double clicking on che drive 8 icon. If you have a 
single drive syscem, press che [Return] key ac che prompc asking you co inserc disk 8 
inco drive A. From chis poinc on, che new STalker disk is considered "Disk 8 ". 

4. Place che original STalker program disk in drive A. If you have a single drive 
syscem, remove che new STalker disk before insercing che original STalker program 
disk. 

5. Open a window co drive A by double clicking on che drive A icon. If you have a 
single drive syscem, press che [Return] key ac che prompc asking you co inserc disk A 
inco drive A. From rhis poinc on, your original STalker program disk is considered 
"Disk A" . 

G. You will now have rwo windows open, one labeled "A" and che ocher labeled "8". 
Drag rhe STALKER.PRG file and che STALKER.RSC file from che "A" window 
(che original STalker program disk window) over co che "8" window (che new 
STalker disk window). This will copy che STalker program co che new STalker 
disk. 

Nore: If you have a single drive syscem, che operaring sysrem will ask you for a series of 
disk swaps. These messages will prompc you ac differenc rimes co inserc disk A 
(che original STalker program disk) or disk 8 (rhe new STalker disk) inco drive 
A. Carefully follow chese prom pes and be cercain co inserc che correcc disk so 
char all che STalker files are copied correcdy. 
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4. · Running STalker 3 

4.1 . Running as a GEM Program 
You can run STalker as a stand alone GEM program by double-clicking on the 

STALKER.PRG icon. The STalker program will load into memory and begin to run. 

4.2. Running as a Desk Accessory 
If you have installed STalker as a desk accessory, pressing the reset button on the 

computer (with your boot disk in drive A for floppy based systems) will cause STalker to 

load and install itself in memory. 

Once STalker is loaded, you can access it by moving the mouse to the Desk or Atari 
Logo drop-down menu (this is the leftmost menu) and selecting the STalker : Off-line 
entry. (The "Off-line" part of the entry will change as you use STalker.) 

When STalker is running as a desk accessory, it is available inside any regular GEM 
program that lets you access the desk accessory menu. Some programs (usually those 
ending in .TOS or .TIP) do not allow access to desk accessories until you have exited 
them. 

The most convenient feature of running STalker as a desk accessory is that it never 
stops running as long as you are using GEM based programs. For instance, you can be­
gin downloading a file from a BBS, then close the STalker window and use another 
GEM based program, and the downloading will continue in the background. 

Note: A common mistake people make when first using STalker is to have the desk 
accessory version of STalker in memory (you will see "STalker: Off-line" under 
the Desk menu) at the same time that STalker is running as a program. Doing 
this will cause both copies of STalker to read data from the communications port 
at the same time, and can lead to unpredictable results when trying to use 
STalker's features . The solution is to make sure that the desk accessory version 
of STalker is not present when you want ot run STalker as a program. 

4.3. Running as a NeoDesk Accessory 
You can install STalker as a NeoDesk Accessory. These are special desk accessories 

which can communicate with Gribnif Software's NeoDesk 3 and NeoDesk 4 desktop 
replacements. This gives the STalker accessory some extra capabilities . For more in­
formation, check the Using STalker with NeoDesk section of this manual. 
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5. Operating STalker 3 

5.1. Introduction 
For the most part, STalker works just like any other GEM program or desk accesso­

ry, and is completely consistent with the GEM program design guidelines. This makes 
it easier for you to learn how to use STalker because you can apply the knowledge you 
have acquired from using other GEM programs. 

5.2. Dialog Boxes 
When you issue a command to STalker, it will sometimes need to ask you for in­

formation . When this happens, STalker will display a Dialog Box on the screen. A dia­
log box has a tide bar at the top, followed by a series of "video buttons" and/or text 
fields. 

STalker~ file Transfer Settings 

Text IASCIII file Transfers ---- Title Bar 
Add llnefeeds 1fter CRs: 0 Line Nil t UOths of • secl: 

1 
a __ 

Host pro11pt string: 1-----
Expand blank II nes as: ---
Strip llnefeeds: • 

--- Text Field 
Az 11arks end of file: 0 

Pro to co I : ~..I _ __:Z;.:;H o:.:d"'ell"----' Auto-start ZH/B-Pius transfers: • ~Buttons Dinar file Transfers 

f llena11es: 
Subdlrs: ----Radio Buttons 

Video buttons display various options available, while text fields are spaces into 
which you can enter information. 

When video buttons are used in a dialog box, you will notice that some of them 
may be displayed in reverse video (white letters on a black background). These buttons 
are referred to as selected, and show the currently active option. To select a deselected 
video button, place the mouse pointer inside the video button you want to select, then 
click the left mouse button. The button will change to reverse video to indicate your 
choice. A button whose text is displayed in light gray cannot be selected. 

Some buttons are mutually exclusive (that is , you can only select one button out of 
a set) . A set of mutually exclusive buttons are called "radio buttons". When you select a 
new radio button, the previously selected one automatically deselects . 
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At the bottom of a dialog box there are always two exit buttons, marked OK and 
Cancel. You must select one of these buttons to exit the dialog box and continue oper­
ating STalker. If you select rhe OK exit burton, any changes you made co rhe dialog box 
will rake effect. If you select Cancel, any changes you made will be ignored. Until you 
exit the dialog box , operation of STalker is frozen. One of rhe exit buttons is high­
lighted with a chick border. This is called the defaulr button. To choose chis button 
without using the mouse, press the [Return] key on the keyboard. 

Some dialog boxes have additional exit buttons; these are grouped together with OK 
and Cancel. 

Occasionally, choosing a button will resulr in the display of a second dialog box. 
You can recognize chis type of burton because the text within rhe button ends in three 
periods. When you exit chis secondary box, you will be returned co rhe main box. (In 
STalker, rhe only exceptions to chis rule are rhe Settings buttons in rhe Autodialer Direc­
tory Dialog Box. They are roo small for rhe periods co fir.) 

In addition co the video buttons, some dialog boxes have rexr fields. Empey rexr 
fields are displayed as a series of underline characters. The chin vertical line in rhe up­
permost text field is rhe cursor, which shows where your typing will appear. To enter 
informacion into rhe text field where the cursor is located , simply type on the keyboard. 
Some text fields may expect a certain type of information, such as numbers only. In chis 
case, only rhe correct keys will be accepted; any ochers you type will be ignored. 

While typing into a rexr field, you have several options. 

Moving: To move the cursor within a field, use the left and right arrow keys on rhe 
keyboard. 

Deleting: 

Erasing: 

To del ere rhe character co rhe left of rhe cursor, press rhe [Backspace] 
key. To delete the character co the right of the cursor, press rhe [Delete] 
key. 

To completely erase a field, press the [Esc] key. 

To move rhe cursor from field co field , there are also several options: 

I . Move rhe mouse pointer over rhe field you want, and left-click. 

2. Use rhe up or down arrow keys on rhe keyboard. 

3. Press the [Tab) key. 

The final feature of a STalker dialog box is a vertical scroll bar. The only STalker 
dialog box in which chis appears is rhe Autodial Directory box, which is displayed when 
you choose the Autodialer Directory ... option from the Dial drop-down menu. 

STalker maintains a list of up co 30 numbers in irs Autodialer Directory, bur only I 0 
are displayed at a rime. The scroll bar, displayed co the left of rhe lise of numbers, allows 
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you to scroll up and down the list. The white rectangle, called the scroll box, represents 
the part of the list you can see, while the gray region represents the part of the list you 
cannot see. To view different parts of the list, point to the scroll box with the mouse 
pointer, press and hold the left mouse button, drag the scroll box to a different part of 
the scroll bar, and release the mouse button. You can also scroll up or down one num­
ber at a time by pointing to the up or down arrows at the top or bottom of the scroll bar 
and clicking the left mouse button. 

The FormDo!t! utility included in the EXTRAS folder on your STalker disk extends 
the capabilities of dialog boxes. See the documentation file included with FormDo!t! foe 
further information . 

5.3. Menu Bar 
This is the STalker menu bar, with a menu visible. 

(1\ file 0 tions Hel 
operation 

Clear ~indo~ contents ACJr 

5.3.1. Running as a program 

When you run STalker as a program, you will see the STalker menu bar at the top 
of the screen. To activate the menu bar, move the mouse pointer over one of the menu 
headings. The menu will drop down. To view different menus, move the pointer over 
the heading of the menu you wish to view. 

To make a choice from a menu, move the mouse pointer over the option you want. 
When the option is highlighted (displayed in reverse video) press the left mouse button. 
Options displayed in light gray text may not be selected. 

Menu options that result in the display of a dialog box always end in three periods. 

Some menu options may be toggled on and off by selecting them. The first selec­
tion turns the option on , a subsequent selection turns it back off, and so on. When this 
type of option is toggled on , a check mark will appear in the menu to the left of the op­
tion name. 

To remove a menu without making a choice, move the mouse pointer completely 
off the menu, then press the left mouse button. 
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5.3.2. Running as a desk accessory 

When you run STalker as a desk accessory, the stand-alone application currently in 
use keeps its menu bar at the top of the screen. The STalker menu bar is placed inside 
the STalker window, directly under the window title bar. 

When STalker is running as a desk accessory, its drop-down menus may be accessed 
only if the STalker window is the currently active (top) window. If it is not, left-click 
(click the left mouse button) anywhere inside the STalker window. 

To activate STalker's menus, place the mouse pointer over the menu heading you 
wish to view and left-click. The menu will drop down. From this point on , the STalker 
menus operate in the same manner as explained previously. 

5.3.3. Keyboard shortcuts 

When you look at the menu entries, you will notice that some of them have a key­
board shortcut shown to the right of rhe enrry. Typing a keyboard shortcut has rhe 
same effect as choosing rhe menu enrry wirh rhe mouse. To use a keyboard shorrcur, 
press down rhe appropriate ser of keys, all ar rhe same rime. The up arrow character 
represents rhe [Shift] key, rhe exploding box character represents rhe [Alternate] key, and 
rhe carer character (I') represents rhe [Control] key. 

To see a lisr of additional keyboard commands , press rhe [Help] key or choose Key­
board .. . from rhe Help menu. 

5.4. Window Controls 
STalker uses a GEM window which is similar to orher GEM windows. However, 

in addition to rhe standard GEM method of moving and resizing a window (by using 
rhe Drag Bar and Resize Cadger, respectively), STalker also allows you to use rhe righr 
and lefr mouse buttons together ro move and resize rhe window. This gives you addi­
tional flexibility wirh rhe mouse. 
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Title Bar 

"" Menu Bar~--~~~!!~_!~~~~~!_~~ 
(only in ACC 
mode) 

Full-Size 
Button 

Scroll Box 

1:.;.;;11--- Vertical Scroll 

Data 
Region 

5.4.1. Title bar (shows Status Line or Menu Bar) 

Bar 

Resize Gadget 

The top line of the STalker window is called the title bar, and normally displays the 
current status of STalker (On-Line, Off-Line, File Transfer Complete, etc.) When in 
Desk Accessory mode, the Menu Bar is located directly below this Status Line. By se­
lecting the Title Bar command on the Options menu, you can turn off the Status Line 
display. If you do this, the Menu Bar will be displayed in the Title Bar. To redisplay 
the Status Line, choose the Title Bar option a second time. 

5.4.2. Moving the window 

When the Status Line is visible in the Title Bar, you can move the window to a new 
screen location by pointing anywhere within the Status Line, then pressing and holding 
the left mouse button. While holding the button, move the mouse and a "ghost win­
dow" will move with the pointer. When the "ghost window" is where you want it, re­
lease the mouse button and the window will jump to its new location. This operation of 
holding a mouse button while moving an object to a new location is referred to as 
"dragging". 

When the Menu Bar is visible in the Title Bar, you can drag the window as de­
scribed above, except that the mouse pointer must point to the blank section of the 
Menu Bar, to the right of the [Help] entry. 

Another way to move the window is to use the right and left mouse buttons togeth­
er. To do this, first position the mouse pointer anywhere inside the window. Then 
press and hold down the right mouse button (or the [Alternate] key on the keyboard), 
and then , while holding the button or key, press and hold the left mouse button. The 
mouse pointer will change from an arrow to a flat hand. At this point, you can release 
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the right button or [Alternate] key, but continue to hold the left button. As you move 
the mouse while holding the button, you will see the "ghost window". To reposition 
the window, move to the location you desire and release the button. 

5.4.3. Close button 

The close button, located at the upper left-hand corner of the STalker window, 
works like any standard GEM window close button. 

If STalker is running as a desk accessory, pressing this button will close the STalker 
window. However, if you are connected to a host system, you will not be disconnected, 
and any data transfer going on will continue to take place. Reopening the STalker win­
dow will allow you to check the status of your connection. 

If STalker is running as a program, pressing this button will exit the program. If 
you are in the middle of an upload or download operation, you will not be allowed to 
exit until the operation is completed or you terminate it. 

If you turn off the display of the Status Line by selecting Title Bar on the Options 
menu, the close button will also disappear. Pressing (Aiternate][Q] will produce the 
same effect as the close button. 

5.4.4. Full Size button 

The full-size button, located at the upper right-hand corner of the window, will 
cause the STalker window to jump between the current window size and the largest pos­
sible size (usually the size of the desktop). The first rime you click on the full-size bur­
ton, the window will grow to full size. A second click on the button restores the 
window to irs original size. If you hold down the [Alternate] key while left-clicking, the 
window will be restored to the size saved in STalker's default information file (the initial 
window size). 
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If you turn off the display of the Status Line by selecting Title Bar on the Options 
menu, the Full-Size button will disappear along with the Status Line. You can still grow 
or shrink the window by pointing to the upper right of the Data Region and holding the 
right mouse button or [Alternate] key while pressing the left mouse button. 

5.4.5. Resize gadget 

The Resize Gadget is located in the bottom right-hand corner of the window. You 
can make the STalker window a new size by using the left mouse button to drag the 
gadget to the location where you want the window's bottom right corner. Release the 
button, and the window will resize itself. 

Note that if you turn off the Vertical or Horizontal Scroll Bar by using the ap­
propriate entry on the Options menu, the Resize Gadget disappears along with the scroll 
bar. 

Even with the Resize Gadget missing, you can still resize the window. Simply point 
the mouse pointer to the bottom right corner of the window (but not within the scroll 
bar, if one of them is still visible.) Then, press and hold first the right button (or 
[Alternate] key), then the left button. The mouse pointer will change from an arrow to 
a pointing hand. At this point, you can release the right button or [Alternate] key, but 
continue to hold the left button. You can now resize the window. If you get the flat 
hand (move window) icon rather than the pointing hand, you didn't point to the right 
place. Release the buttons and try pointing closer to the corner of the window. 

18 



Gribnif Software Operating STalker 3 

5.4.6. Scroll Bars 

STalker allows you to have a virtual screen size of up to 9999 lines by 200 columns 
(virtual screen size is controlled by the Preference Settings ... command on the Settings 
drop-down menu). This simply means that STalker maintains a buffer (an area of 
memory) in which it stores up to the last 9999 lines received from the computer system 
you are connected to. Additionally, the buffer can store more columns than the window 
can display. The vertical and horizontal scroll bars, at the right hand side and bottom of 
the window, respectively, allow you to scroll around this virtual screen. 

Scroll Boxes 

Horizontal Scroll Bar 

Vertical 
Scroll Bar 

The vertical scroll bar, located on the right side of the window, controls which sec­
tion of the (up to) 9999 line virtual screen is visible. The white rectangle, called the 
scroll box, represents the part of the virtual screen you can see, whil'e the gray region 
represents the part of the virtual screen you cannot see. 

To go to a different portion of the virtual screen, point to the scroll box with the 
mouse pointer, press and hold the left mouse button, drag the scroll box to a different 
part of the scroll bar, and release the mouse button. While dragging, you will see an 
outline of the bar, called the "scroll drag box". 

You can scroll one line at a time by clicking the left mouse button while pointing to 
the Scroll Arrow at the top or bottom of the scroll bar. This can also be accomplished 
by holding down the [Control] key and pressing the up and down arrow keys on the 
keyboard. 

You can move up or down a page at a time (the size of a page is the same as the cur­
rent window size) by clicking the left mouse button while pointing to the gray area 
above or below the scroll box. This can also be done via the keyboard by holding down 
the [Shift] key and pressing the up or down arrow keys. 

The [Cir/Home] key takes you to the top of the virtual screen, while 
[Shift][Cir/Home] takes you to the current cursor position. 
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The horizontal scroll bar, located at the bottom of the window, operates in the same 
manner as the vertical scroll bar, but its keyboard equivalents use the left and right ar­
rows rather than the up and down arrows. 

Either or both of the horizontal and vertical scroll bars may be turned off by using 
the appropriate command in the Options menu. This gives you more space on the 
screen to display data. If you turn off a scroll bar, you can still scroll around the virtual 
screen by using the keyboard commands ([Shift] arrow to go page by page, arrow keys 
alone to go line by line, [Cir/Home] to go to the top of the virtual screen, and 
[Shift][Cir/Home] to go to the current terminal cursor position) 

When you turn off one or both of the scroll bars, the resize gadget also disappears. 
It will reappear if you turn on both scroll bars. Remember that even when the resize 
gadget is gone, you can still resize the window by using the left and right mouse buttons 
together, as previously explained. 

5.4.7. Data region and virtual screen 

The Data Region is the main section of the STalker window. This area displays the 
data sent and received by you and the computer system to which you are connected 
(called the host system). It is your window on the virtual screen, in which STalker holds 
up to 9999 lines by 200 columns of text. Use the scroll bars to scroll around the virtual 
screen. Use the Preference Settings ... command on the Settings menu to adjust the size 
of the virtual screen. To erase the virtual screen (not just the part visible in the data re­
gion), choose Clear Window Contents from the Edit menu. 

The cursor, which is the small black square within the data region, shows where the 
next character you type, or the next character received from the host system, will appear. 

Data Region 

5.4.8. Cut and paste/block functions 

Block functions enable you to retransmit, save to disk or print portions of the virtu­
al screen. You can even paste text directly into STeno, Gribnif Software's desk accessory 
text editor. Once there, you can edit it and then send it back to STalker to be 
retransmitted! 
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5.4.9. Selecting a block 

"Selecting a block" means that you highlight a piece of text within the virtual 
screen. The highlighted text is called a block, and you can execute any of the block 
commands on it. 

To select a block, place the mouse pointer at the beginning or end of the text you 
wish to select, then press and hold the left mouse button and move the mouse to the op­
posite end of the desired text. The block will be displayed in reverse video. A shortcut 
is to hold down the [Shift] key as you press the button; STalker will then select the text 
between the terminal cursor and the mouse pointer. If the block you want goes off the 
top or bottom of the data region, just move the mouse past the top or bottom edge of 
the region (while still holding the button), and it will scroll. If you hold the [Alternate] 
key, scrolling will be screen by screen. Otherwise it will be line by line. Move the 
mouse back inside the data region to stop the scrolling. When the block is defined as 
you want it, release the button, and the block action window will appear. 

This window has six opti~ns which act on your block. Point to an option with the 
mouse pointer (it will display in reverse video) and left-click. If you choose a block and 
then decide you do not want to execute a block command, move the mouse pointer 
completely off the block action window and left-click. The window will disappear and 
the block will deselect (no longer be selected). 

5.4.10. BlockAction Window options 

STalker maintains an invisible text clipboard on disk. 
In addition to the commands in the Block Action Window, 
some of the commands on the Edit drop-down menu also 
act on this clipboard; see the section of this manual on 
that menu for further information. If you are using STe­

Action 

no, you should be aware that STalker and STeno normally use the same clipboard file. 
Therefore, any clipboard operations you do in one program may affect the other as well. 
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Block Action Window commands are: 

• Append to clipboard: This command adds the currenrly selected block to the end 
of any text already in the clipboard. 

• Copy to clipboard : When you execute the Copy to Clipboard command, any text 
already in the clipboard is erased and replaced by the currently selected block. 

• Paste to STeno : If you have ST eno in memory, the currenrly selected block will be 
copied to STeno's current text file at the current cursor position. It is not necessary 
to have the ST eno window open in order to paste to it. 

• Print: This option sends the currently selected block to your printer. 

• Save to disk : This option saves the currently selected block to a text (ASCII) file. 
You will see the GEM file selector (see picture below). Choose the path you want, 
then enter a filename and choose the OK button. To abort the save, choose the 
Cancel button. For further information on the GEM file selector, consult your 
Acari computer owner's manual. 

• Transmit: The block is sent over the currently selected communications port, 
using the current text transfer settings. This command is identical to Copy to 
Clipboard followed by Paste Clipboard (text) from the Edit menu. 
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6. Introduction to 
Telecommunications 

6.1. Introduction 
This section of the manual assumes you know nothing about computer telecommu­

nications. If this is not the case, you may just want to skim this section. It also does not 
attempt to explain every possible feature of STalker. For detailed information on every 
STalker command, refer to the Drop-Down Menu section of this manual. 

6.2. Connecting Computers Together 

6.2.1. M odems and null modem cables 

Computers communicate over phone lines through the use of a modem. A mo­
dem, which stands for Modulator-demodulator, transmits by changing information 
coming out of your computer's serial port into signals which may be transmitted over 
normal telephone lines. It receives information by taking signals from the phone line 
(sent by another modem) , changing that information back to its original form, and feed­
ing it into your computer's serial port. 

Modems typically have three jacks. One is a 25-pin DB-25 port. You plug a mo­
dem cable into this port, and connect the other end to your Atari's serial port. The other 
two ports are modular phone jacks. One of these jacks (usually labeled "Line") should 
be connected to a modular wall phone jack via a standard phone cable (usually supplied 
with the modem). The other jack is connected to your phone using the phone's cable. 
Thus, when you are not using the modem, your phone works normally. Note that 
when the modem is connected to another computer, your phone line is in use and any­
one calling you will get a busy signal. If you have call waiting, you should turn it off as 
the call waiting "beep" will interfere with the operation of the modem. 

Sometimes you might want to connect two computers which are in the same room 
by running a cable directly between them . In this case, the modems are not needed as 
no phone line is involved - the information can be sent directly from one computer to 
the other. However, you cannot use a regular modem cable for the connection; you 
must use a null modem cable. The reason for this is twofold: the "sexes" of the connec­
tors won't match , and the wiring would be incorrect. A null modem cable is a standard 
item a~ailable at any computer store. As far as the operation of STalker is concerned, it 
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does not matter whether you are using a null modem cable or a modem. Of course, if 
you are using a null modem cable, you don't have to dial the other computer as you are 
already connected! 

6.2.2. Hayes and Hayes compatible modems 

There are certain commands you can send to a modem, such as telling it to dial a 
certain phone number, disconnect from a connection, etc. The modem may also be set 
for various possible options, such as whether or not to answer an incoming call auto­
matically. To simplify communications between computers and their modems, most 
modem manufacturers have a standardized set of modem commands called the AT set, 
so-called because all the commands start with AT. Also, modes in the modem are set via 
a set of built in registers. The command set and registers were created by Hayes, a pop­
ular modem manufacturer, and so modems using the AT command set and Hayes regis­
ters are said to be "Hayes compatible". You should try to stick to a Hayes or Hayes 
compatible modem for use with your Acari, as virtually all modem software, including 
STalker, is preconfigured for this type. 

6.2.3. High speed modems 

Newer modems automatically adjust to whatever speed the computer talks to them 
at. Furthermore, these modems will usually try to connect to the remote host at the 
highest possible rate, by default. For this reason, if your modem's manual says that it 
can automatically recognize the computer-to-modem connection rate, you should set 
STalker to always use the fastest communications rate supported by the modem. The 
modem should decide for itself what rate to connect to. the remote modem with. 

6.3. Configuration Definitions 
Modems have many different parameters, such as the speed at which they transmit, 

the codes used for each character sent, and so on. Both STalker and the software at the 
other end of the line must be configured in the same way for communications to pro­
ceed properly. To set up the modem, choose Communication Settings ... from the Set­
tings drop-down men u. When you do, you will see the Communication Settings dialog 
box (see picture on next page) which will enable you to set up your system using the 
following parameters: 

6.3.1. Baud rate 

The Baud Rate refers to the transmission/reception speed of your modem. Baud 
Rate is measured in bits per second. The speed at which characters are transmitted is 
roughly the baud rate divided by 10. 

Modems rated at a certain maximum speed, such as 2400 baud, can also use the 
common lower speeds of 1200 and 300 baud. Therefore, if you have a 2400 baud 
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modem but you are connected to a computer with a 1200 baud modem, set your mo­
dem to 1200 baud. 

The Communications Settings dialog box 
STalker~ CoMMunitation Settings 

Baud Rate: 2400 

Mode: lii!III•J!f!1IM Etho (Half Duplex) Ill Lotal I 

FloH Control: Hone MJ•I:W•IiU RTS/CTS Ill Both 

Parity: 

Word Length: Is BitsNIUM 6 Bits Ill 5 Bits 

Stop Bits: • 1.5 - 2 

[][] lcha n ge A 111 I.__---=C=ha=o"'-ge::........::..Of:....:.f.....:-L::..::i=oe=----_. lcantell 

6.3.2. Full/Half Duplex 

Some computers you may connect ro will echo back characters you rype on your 
keyboard. This echoing is referred ro as full duplex. In full duplex, if you type a 't', that 
letter will be transmitted to the other computer, and the other computer will then send a 
't' back ro your computer. Since STalker displays any incoming information from the 
modem on your screen, the 't' from the other computer will appear. Therefore, if 
STalker were ro also display a 't' at the instant you ryped it, you would end up with two 
't's! Thus, in full duplex mode, STalker does not display each lerrer as you rype it, but 
instead waits for the echo. 

If the computer does not echo back characters , the connection is referred to as half 
duplex. In half duplex mode, it is necessary for STalker to display each letter as you type 
ir. Here is how ro tell which mode ro use. If you are connected to a computer and you 
see rwo lerters appear for each one you rype, switch ro full duplex mode. If you cannot 
see anything you are typing, switch to half duplex mode. 

STalker also supports a mode called local, in which anything you rype appears on 
the screen but is not sent to the modem. 

6.3.3. Word length 

Computers communicate through the use of groups of 1 's and O's. Each group rep­
resents one character. The word length refers ro how many I 's and O's make up one 
group. The most common word lengths used are 7 or 8. If you connect ro a system and 
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get gibberish on the screen, try changing the word length and parity from 7/even to 
8/none or vice versa. 

6.3.4. Stop Bits 

Stop bits mark the end of a character. Most systems use 1 stop bit. 

6.3.5. Parity 

Parity checking is a form of error detection . Generally, when you are connected to 
a system using 7-bit words, you should set parity to Even. When you are connected to a 
system using 8-bit words, set parity to None. 

6.3.6. Flow Control 

Sometimes a computer can't process data coming in over a modem fast enough. 
Flow control permits a computer which is falling behind to tell the other computer to 
temporarily stop transmitting. When the receiving computer catches up, it can then tell 
the other end to start transmitting again. X ON/X OFF is the most common form of flow 
control. 

At baud rates of 9600 or greater, RTS/CTS flow control should be used. However, 
not all version of the Acari operating system support this type of flow control correctly. 
See the High Speed Modem section of this manual. 

If you are reading information coming in from a host computer and you are falling 
behind, you can do your own flow control. Just hold down the [Control] key while 
pressing the [S] key to stop the transmission of data. Press [Control] and [Q] to restart 
transm tsston. 

6.3.7. Terminal Emulation 

STalker emulates three popular terminal protocols: VT-52, VT-100, and PC­
ANSI. Which one you will use depends on the system to which you are connecting. 
Choose your terminal type from the Terminal Settings dialog box, viewed by choosing , 
Terminal Settings .. . from the Settings drop-down menu. 

PC-ANSI is sometimes called ANSI-BBS, ANSI, et al, by some systems. Also, the 
VT-52 emulation is the Acari Enhanced VT-52 and contains additional capabilities over 
and above the standard VT -52. 

If you can read text coming in, but the text appears scrambled or has strange char­
acters interspersed with the readable portion, try changing to a different terminal type. 
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6.4. How to Connect To a host System 
Note: The following assumes you have a Hayes-compatible modem. 

STalker supports an autodialer directory of up to 30 different entries. Each entry 
will store individual information on the phone number, baud rate, and all the other set­
tings needed. In addition, you can even program the autodialer to log in for you by typ­
ing your password and any other necessary information automatically! If you are going 
to call a BBS or On-Line Service frequently, you should program it into the autodialer 
directory. If you are only going to call once, you can connect manually. Use of the Au­
todialer is explained in the section of this manual covering the Dial menu. For now, 
you can just dial manually. 

6.4.1. Set configuration, terminal settings, etc. 

First, you must set up the communications settings properly using the Communica­
tions Settings dialog box. If you are dialing into a commercial service like GEnie or Com­
puServe, use the settings they give you. If you are dialing a public BBS, generally your 
settings should be XON/XOFF flow control, and either 8 bits/no parity or 7 bits/even 
parity. Baud rate and duplex depends on the system you are calling - most BBS's sup­
port 2400 baud but not all, and duplex settings vary. Refer to the previous section of 
this manual for information on these settings. 

The next thing you should do is set your terminal emulation to the correct type us­
ing the Terminal Settings dialog box. If you don 't know which type the system you are 
dialing expects, use YT-52. 

Finally, if you are planning to do any file transfer, you may wish to open up the File 
Transfer Settings dialog box by choosing that option from the Settings menu and choose 
the type of transfer protocol you will be using. (Of course, you can also do this after 
you are connected; see the File Transfer section of this manual for further information.) 

6.4.2. Dialing 

Once your settings are correct, you are ready to dial. Type ATDT (for tone dialing) 
or ATOP (for pulse dialing) followed by the phone number you want to call. For in­
stance, if you were dialing 1-555-5555, you would enter: 

ATDT 1-555-5555 [Return] 

to dial. (The dashes are optional.) 

If your modem has a speaker, you will hear the process of dialing and connecting as 
it proceeds. When you are connected, you will be informed by a message on the screen. 
What happens next depends on the system you are connecting to. Generally, you 
should press the [Return] key once or twice. 
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If you get a response but it is completely unreadable, cry changing the communica­
tion settings from 8 bits/no parity to 7 bits/even parity or vice versa, chen press the 
[Return] key. This usually fixes the problem. If the text is readable but scrambled on 
the screen, try changing the terminal type. 

At this point, you will probably have to enter a password and/or ocher informacion; 
chis depends on the system you are calling. 

One of the best features of STalker is chat when running as a desk accessory, it op­
erates completely in the background. This means that you can use STalker at the same 
time as another GEM based program. While STalker works on a lengthy file transfer, 
you can get on with your work - no waiting! If you are running STalker as a desk acces­
sory, once you are connected to a host system you can cry chis feature out by closing the 
STalker window and entering a GEM based program, then reopening the STalker win­
dow. Try using STalker and the ocher program at the same time. 

6.4.3. Hanging up 

When you are done communicating, log off from the host system (the system you 
are connected to) . Then choose Hang Up Phone Line from the Dial menu. Last of all, 
you should turn off your modem, as if you leave it on, it may answer the phone when 
you don't want it to! 

6 .5. File Transfer 
One of the major reasons to call other computers is to transfer programs or files be­

tween your computer and the other computer. Sending a file is called uploading, while 
receiving a file is called downloading. 

Remember chat STalker uploads and downloads in the background. This means 
that while you transfer a long file to or from another computer, you can run another 
GEM based program and get on with your work. Once the transfer commences, you 
can even close the STalker window. STalker will notify you when the file transfer is 
complete by playing a shore rune through your computer's speaker. 

6.6. Basics of Uploading/Downloading 

6.6.1. Text (ASCII) Files 

The simplest way to perform a download or upload is to send the informacion char­
acter by character from the first computer co rhe second. In fact, when you receive some 
rexr from the host system and then use STalker's cut-and-paste function (Save to Disk on 
the Block Action Window) to save some text in the virtual screen to disk, you have per­
formed an elementary download operation. If you use the Transmit option from the 
Block Action Window, you have performed an upload operation. 
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In addition to these simple upload/download methods, which operate only on text 
in the virtual screen, STalker also allows you to send a text file stored on disk to the host 
computer, or receive some text and immediately store it to disk. 

• Text File Upload- To send a text file, use the Send Text File ... command on the 
File menu. Upon issuing the command, you will see the GEM file selector. Choose 
the file you wish to send, and it will be transmitted to the host computer. Because 
this is a text upload, the host computer receives the file one character at a time, just 
as if you had typed it yourself. (Of course, you'd have to be a pretty fast typist!) 
Watch the status line at the top of the STalker window for information on the 
status of the upload. 

This is a useful function for electronic mail. You can use your favorite word 
processor to compose your letter, then save it as an ASCII (text) file and upload it 
later. Gribnif Software's STeno text editing program is especially conveniene for 
this, as you can run both STeno and STalker as desk accessories. 

• Text File Download- To receive some text and immediately save it to disk, choose 
Receive Text File ... from the File menu. The GEM file selector box will pop up to 
allow you to name the file in which your Acari will store the data. As soon as you 
choose the OK button to exit the file selector, STalker will start saving incoming 
text. At this poine, you should type the appropriate command to your host system 
to start sending the text you wish to receive. When you are finished receiving, 
choose Receive Text File ... again to complete the transfer. Watch the status line at 
the top of the STalker window for information on the status of the download. 

Note that at any time while incoming text is being saved, you can still type on the 
keyboard to send instructions to the host computer. 

6.6.2. Binary Files 

Sending and receiving files as straight text works fine, but there are problems. 
Sometimes there might be noise on the phone line or other problems which can garble 
the data. Since there is no way to tell what the data is supposed to look like, there is no 
way to check for errors. Also, some files (such as programs) are not readable text and 
cannot be easily transmitted as text. 

To bypass these problems, use binary file transfer. With chis method, the data is 
transmitted along with additional information which allows the receiving computer to 
verify that the data arrived correctly. If it did not, the receiving computer can request 
the host computer to re-transmit the data. STalker supports four basic methods, called 
protocols, of binary file transfer, plus some variations (these are explained later in this 
section). These are XModem, YModem, CompuServe B+, and ZModem. To choose the 
protocol you wane, use the File Transfer Settings ... command from the Settings menu. 
The File Transfer Settings dialog box will appear, (see picture on page after next), and 
you can select the protocol you wane by left-clicking on the button next to the word 
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"Protocol", then making your choice. Exit the dialog box by left-clicking on the OK 
button . 

• Binary Uploads- If you want to do a binary upload of information from the virtual 
screen to the host computer, first store the information you want in the clipboard 
(see Cut and Paste/Block Action Window elsewhere in this manual.) Next, choose 
the transfer protocol you wane, if you have not already done so. Then, tell the host 
computer to get ready for a binary upload (exactly how this is done depends on the 
system to which you are connected) . Finally, choose Paste Clipboard (Binary) from 
the Edit menu. The transfer will begin and you will see a status dialog box. To 
abort the transfer before completion, choose the Abort Transfer button at the 
bottom of the dialog box or press the [Undo] key. 

If the information you want to upload is stored in a disk file, you first need to 
choose the transfer protocol you want, if you have not already done so. Next, tell 
the host computer to get ready for a binary upload (exactly how this is done 
depends on the system to which you are connected) . Finally, choose Upload Binary 
File .. . from the File menu. The GEM file selector will appear so you can choose 
the file to upload. After you exit the file selector, a status dialog box will appear 
with information on the progress of the upload. To abort the transfer before 
completion, choose the Abort Transfer button at the bottom of the dialog box or 
press the [Undo] key. 

If the host you are using supports the ZModem file tranfer protocol, and STalker is 
set to "Auto-initiate ZModem file transfer" (in the File Transftr Settings dialog) , you 
do not need to choose Upload Binary File. Instead, you will be presented with <he 
GEM file selector automatically, as soon as the host computer starts to download. 

• Binary Downloads - When doing a binary file download, it is sometimes 
unnecessary to use the File Transftr Settings ... dialog box to choose a protocol 
because STalker can automatically detect which protocol the host computer is 
using. However, this does not work for YModem-G. If you are using YModem-G, 
you will need to choose that protocol , and if not, choose one of the other protocols. 
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To receive a file, tell the host computer to get ready to start a binary download 
(exactly how this is done depends on the system to which you are connected). 
Then, select Download Binary File ... from the File menu. The GEM file selector 
will appear so you can name the file to be downloaded. After you exit the file 
selector, a status dialog box will appear with information on the progress of the 
download. To abort the transfer before completion, choose the Abort Transfer 
button at the bottom of the dialog box or press the [Undo] key. 

If the host you are using supports the ZModem file transfer protocol , and STalker 
is set to "Auto-initiate ZModem file transfer" (in the File Transftr Settings dialog) , 
you do not need to choose Download Binary File. Instead, you will be presented 
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with the GEM file selector automatically, as soon as the host computer starts to 
download. 

• If you type [Shift][Aiternate][D], STalker will immediately begin a binary download 
without prompting you for a filename. The file will be named RECEIVED.FIL 
unless you are using YModem or ZModem, which transmit the filename. 

6.6.3. Binary file transfer protocols 

• XModem - XModem is the most common binary file transfer protocol. In fact, 
almost all systems support it. There are two versions - standard XModem with 
128 byte blocks, and XModem with I K blocks (both checksum and CRC variants 
are supported automatically). If your host system supports it, use the faster I K 
block protocol. If your host system just says "XModem" without specifying, use the 
128 byte block protocol. When receiving, STalker can tell them apart 
automatically. 

• YModem - STalker supports two versions of the YModem protocol: YModem and 
YModem-G. Use YModem-G only with a null modem cable or error-correcting 
modem, as it does not do error-correction! If an error occurs, the entire transfer is 
canceled. However, the lack of error correction makes YModem-G faster than 
regular YModem or even ZModem. 

• ZModem- ZModem uploads and downloads are automatically detected. Not only 
do you not need to change the protocol choice setting in the File Transfer Settings ... 
dialog box to ZModem before doing a ZModem download, but STalker will 
automatically begin the download without your issuing the Download Binary File ... 
command. Similarly, if the host computer requests a ZModem upload, your 
computer will comply without your issuing an upload command. 

You can turn off this automatic ZModem detection by opening the File Transfer 
Settings dialog box from the Settings menu and deselecting the button to the right 
of the words "auto-initiate ZModem/B-Plus transfers". 

• B-Plus- This file transfer protocol is used exclusively with CompuServe 
Information Services. In order to use this protocol, you must either be using 
STalker as a program, or you must at least be using MultiTOS or the Geneva 
multitasking environment. Also, the Back TALK script directory must be set to the 
location ofBPLUS.TIP. 

A major difference between XModem and Y/ZModem is that XModem does not 
transmit the filename of the file you are uploading or downloading - it only transmits 
the data. YModem and ZModem transmit the filename and time of the transfer along 
with the data. For this reason, YModem and ZModem let you send more than one file 
in sequence. Doing this is called a batch upload; see the section of this manual describ­
ing the Upload Binary File ... menu option for details. 
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STalker~ File Transfer Settings 

Text CASCII) file Transfers 
OOHNLOADS 

Add linefeeds after CRs: [] 

BOTH 

AZ Marks end of file: [] 

Protocol: ./ 

X/VHodeM 1 1 1 

OK I Change All I 

UPLOADS 

Line Hait ClOths of a sec): o __ 
Host proMpt string: 
Expand blank lines as: -.--
Strip linefeeds: 

ZH/B-Plus transfers: • 
• BATCH UPLOAD ( VHODEH + ZHOOEH) OPTIONS .f. 

F i 1 enaMes: .iii* RELIITIVE i§l FULL 1 

Subdirs: *!!.!liM "'m" ij •·• 1 

Change Off-line I Cancel I 

Note: If additional File Transfer Protocols have been added since the printing of this 
manual, they will appear in the above dialog box, and be documented in the 
READ_ME.NOW file on the disk. 
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7. Drop-Down Menus and 
Dialog Boxes 

This chapter explains all of STalker's drop-down menu commands and any result­
ing dialog boxes in derail. To save space, the word "Air" is used instead of the word "Al­
ternate". For example, "[Ait)[l]" means you should hold down the [Alternate] key while 
pressing the [I] key. 

7 .1. Desk (or Atari Fuji) Drop-Down Menu 

7.1.1. STalker info ... [Alt] [I] 

Selecting this option displays a dialog box with important information about the 
version of STalker being used. Write down the version number and serial number dis­
played in this box before calling Gribnif Software for technical support. 

This dialog box also displays how much free RAM you have. 

To exit the box, dick the left mouse button or press any key. 

7.1.2. Desk accessories 

If you are running STalker as a stand-alone program, any desk accessories you have 
loaded will appear on this menu and may be accessed normally. 

If you are running STalker as an accessory, the only entry on the menu will be 
STalker Info. 
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7 .2. File Drop-Down Menu 

7 .2.1. Open configuration file ... 

STalker allows you to have multiple con­
figuration files saved on disk. These files hold 
all the setup information from the various dia­
log boxes, such as the baud rate, etc. 

When you choose this option, you will 
see the GEM file selector. Choose a configu­
ration file, select the OK button, and the file 
will load. Choose Cancel to abort the com­
mand. Values in the Preference Settings dialog 
box that require a reboot to change will not be 
affected by loading a new configuration file. 

7.2.2. Save configuration [Alt] [G] 

This option lets you save the current con­
figuration. The filename used will be the last 
name given in an Open Configuration File ... 
command. If you have not executed this com­
mand, STALKER.INF is the default filename. 

The STALKER.INF file always loads auto­
matically each time you load STalker. If you 
want to use a different file , use Open Configura­
tion Fife ... to load the file you want. 

Note: This option saves all the autodialer 

Send text file... res 
Reteive text file .. , :•JR 
Upload binary file,,, reu 
DoHnload binary file •. , reo 

Invoke STeno~ reTab 
ReMote (Mini-88S) Mode .•. re8 
ShadoH~ atr.ess. , , ~= 

Close WindoH [+~0 

Send text file... res 
Reteive text file... reR 
Upload binary file.,, reu 
DoHnload binary file.,, reo 

Invoke STeno~ reTab 
ReMote (Mini-88S) MOde.,, re8 
ShadoH '~ ar.r.ess . • . :;:= 

Close WindoH 

settings. It is therefore not necessary to save these settings separately in the 
autodialer in order for the settings to be loaded automatically when STalker first 
runs. 

7.2.3. Save configuration as ... 
[Shift] [Alt] [G] 

When you issue this command, you will 
see the GEM file selector. Choose the path and 
filename you want to save your current configu­
ration to, then choose the OK button to save the 
data. Choose the Cancel button to cancel the 
command. 
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ShadoHM ar.r.ess . .. ~= 

Close WindoH r•JO 
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7.2.4. Send text file.. . [Alt][S] 

This command enables you to send a text 
(ASCII) file to the host computer. Upon issu­
ing this command, you will see the GEM file 
selector box. Choose the file you wish to send, 
and it will be transmitted to the host computer 
using the current Text Transfer settings in the 
File Transfer Settings dialog box. Watch the sta­
tus line at the top of the STalker window for in­
formation on the status of the upload . To stop 
the transfer in progress, press the [Undo] key. 

7.2.5. Receive text file... [Alt][R] 

This command lets yo u save incoming text to 
disk. When you issue this command, the GEM 
file selector will appear to allow you to name the 
fi le in . which your Atari will store the data. As 
soon as you choose the OK button to exit the file 
selector, STalker will start saving incoming text. 
At this point, you should type the appropriate 
command to your host system to start sending the 
text you wish to receive. When you are finished 
receiving, choose Receive Text File ... again to com­
plete the transfer. Watch the status line at the top 
of the STalker window for information on the sta­
tus of the download . 

Open tonfiguration file .. , 
Save tonfiguration WG 
Save tonfiguration as ... ~JG 

Send text file... OOS 
Reteive text file... t•JR ~ 
Upload binary file... OOU 
DoHnload binary file... OOD 

Invoke STeno~ WTab 
ReMote (Mini-BBS) Mode .•. WB 
Shadow~ att~ss... ~= 

Close WindoH 

Open tonfiguration file ... 
Save tonfiguration WG 
Save tonfiguration as ... ~~G 

Send text f i 1 e. . . t•JS 
Reteive text file... WR 
Upload binary file... :•JU It 
DoHnload binary file... OOD 

Invoke STeno~ OOTab 
ReMote (Mini-BBS) Mode,., 008 
Shadow~ att~ss ... ~= 

Close WindoH (+10 

Note: At any time whi le incoming text is being saved, you can sti ll type on the 
keyboard to send instructions to the host computer. 
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7.2.6. Upload binary file... [Alt][U] 

file ... 
{+J6 

as ... «•J6 

t+lS 
{+lR 

This command lets you send a file to the 
host computer, using the settings and binary 
file transfer protocol currently selected in the 
File Transfer Settings... dialog box. Before se­
lecting this command, tell the host computer to 
get ready for a binary upload (exactly how this 
is done depends on rhe system to which you are 
connected) . Then, choose the command. The 
GEM file selector will appear so you can choose 
the file to upload. After you exit the file selec­
tor, a status dialog box will appear with descrip­
tive information on the progress of 

Invoke STeno~ OOTab 

the upload. 

Status messages and errors are 
displayed in the Messages portion of 
the box. Efficiency rates the speed 
of your data transfer where 100% is 
the theoretical maximum speed 
(baud rate divided by 1 0). To abort 
the transfer before completion, 
choose the Abort Transfer button at 
the bottom of the dialog box or 
press the [Undo] key. 

When you are using YModem 
or ZModem, you can do batch 
uploads. Barch uploads let you 
send a group of files with one 

ReMote (Mini-BBS) MOde ... OOB 
Shadow'" at tess. . . :;::: 

Close Windo~o~ 

2SX 50 X 7SX 

I 

file naMe: PIC.PC3 
Drive & direttory: D: NEDDESK3 

Bytes transferred/left: 0121048 
TiMe elapsed/left: O:OB/0:90 
Effitienty: 0 tps, BY. 

Total errors: 0 ChetksuM: 

il4i¥ti4 

upload command. To do rhis, en- Abort Transfer 
ter a file specification using wild-

I 

cards. Wildcards are special characters that substitute for all or part of a filename. The 
'* ' character substitutes for a whole section of a filename, while the '?' character substi­
tutes for only one letter. 

For instance, if you wanted to send all files with a '.TXT' extension in a certain di­
rectory, you would first choose that directory in the GEM File Selector, and then enter 
*.TXT for a filename. If you wanted to send all files called STUFF, regardless of the ex­
tender, you would enter STUFF.* for a filename. If you had a series of files called 
STUFF1 .TXT, STUFF2.TXT, and STUFF3.TXT, you would enter STUFF?.TXT for a 
filename. Parameters for batch uploads are set by invoking the File Transfer Settings ... 
command on the Settings drop-down menu. Refer to the instructions for this com­
mand for further details. 
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7.2.7. Download binary file... [Alt][D] 

This command lets you receive fil fi 
the host computer. STalker will try 
matically detect the binary transfe 

a 1 e rom 
to auto-

r protocol 
your host system is using, so it is no t necessary 
to access the File Transfer Settings .. . dialog box 
unless, you are using YModem-G as y our trans-
fer protocol. 

get ready 
his is done 
u are con-
nd. The 
can name 

file naMe: 

mil 
Open ronfiguration file ... 
Save tonf i guration (+J6 
Save tonfiguration as I I I <I<+JG 

---------------------------------
Send text file ... [+JS 
Receive text file,., [+JR 
Upload binary file.,, (+]U 

-I 1l~lol11l;' 1 I Iiiii· 1------------------------------ -- ·~-
Invoke STeno"" :•JTab 
ReMote (Mini -BBSl Mode ... (+]B 
ShadoH~ attess . .. :!:= 

---------------------------------
Close Windo~o~ (+JD 

XModel'l Do~omload Status mm:mH"!""'"' ,,, .. · 

NEW.TST 

First, tell the host computer to 
for a binary download (exactly how t 
depends on the system to which yo 
nected.) Then, choose the comma 
GEM file selector will appear so you 
the file to be downloaded. After you 
exit the file selector, a status dialog 
box very similiar to the Upload Sta­
tus dialog box will appear with de­
scriptive information on the progress 
of the download. Status and error 
messages are displayed in the Mes­
sages portion of the dialog box. To 
abort the transfer before completion , 
choose the Abort Transfer button at 
the bottom of the dialog box or 
press the [Undo] key. When the 
transfer terminates, you will hear a 
shore tune, and a message will ap­

Drive & directory: D:\ 

Bytes/blotks transferred: 0/0 
TiMe elapsed/left: 0 :00/? 
Effitienry: 0 rps, 

Total errors: 0 ChetksuM: 

pear in the STalker window. I 

7.2.8. Invoke STeno [Alt][Tab] 

If you have STeno, Gribnif Software's text 
editor loaded , this command will open and acti­
vate the STeno window. 

I 

:fn!WlJ 

Abort Transfer I 

Open tonfiguration file ... 
Sav~ tonfiguration OOG 
Save tonfiguration as ... <:<~G 

Send text file.,, OOS 
Reteive text file... OOR 
Upload binary file... OOU 
DoHnload binary file.,. OOD 

ox 

I 

If STeno is not loaded, this option will be 
grayed out and will not be selectable. 'I. 

See the chapter Using STeno with STalker 
for information on setting up STeno. 

ReMote (Mini-BBSl Mode,,, 008 
ShadoH~ attess... ~= 

Close WindoH 
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7.2.9. Remote (mini-BBS) mode... [Alt][B] 

This option allows you co dial in with 
another modem-equipped computer and access 
your system. This function is useful if you will 
be travelling and may need to upload or down­
load files from your system. 

When you issue chis command, you will see 
the STalker Remote Mode Settings dialog box. By 
configuring the dialog box as described below, 
chen exiting the box with the Remote Mode exit 
buccon, you can access your system via another 
computer/modem. The computer you call from 
is called the remote computer. 

Open configuration file.,, 
Save configuration 006 
Save configuration as ... «~6 

Send text file.,, OOS 
Reteive text file... ~m 
Upload binary file,.. OOU 
DoHnload binary file.,, OOD 

STeno~ OOTab 
I I I I' 

access , , , :+:= 

Close WindoH [+}0 

At the cop of the Remote Mode 
Settings dialog box, there are three 
text fields labelled Modem lnit, Sign 
On Password, and CLI Password. 
The default value for Modem lnit is 
correct for Hayes compatible mo­
dems. If your computer uses a differ­
ent cype of modem, change chis field 
co the appropriate value for that mo­
dem. The Sign On Password field is 
the password you will need co enter 
when you connect co your system. 
Clear the field by pressing the [Esc] 
key, chen cype in your desired pass­
word. The CLI Password field lets 
you enter a password co rescricc access 

STalker~ ReMote Mode Settings 

ModeM lnit : ATSO=!}~-------
Sign On PassHord: cHidden~ 
CLI PassHord : cHidden~ 

Initial Port Settings,,, 

o CLI Shell PrograM Cclitk to change) o 

Bypass SysteM Error Handler [] 
1' THIS HILL. ,.iltEV.NT THE HIUTI: ~iltOTECT , ."D DISK t 

Baud Rates to Use 

lm!EII BlEil mEI!II 
- 24oo -~s IIHillll lmi!II 

co a CLJ (Command Line Interpret- ReMote Mode OK Cantel 
er) program which may be accessed 
from che remote computer. Enter a password here. When you exit che Remote Mode 
Senings dialog box, these passwords will be hidden , and you will not be able to view 
them again. If you forget your entries, you must dear the fields and enter new pass­
words. If either password is left completely blank. STalker will not ask for a password 
before granting access to the caller. 

The Initial Port Settings ... bunon lets you configure the setup o(your modem. 
The resulcing dialog box is the standard STalker communications senings box, described 
Iacer in chis chapter. It is helpful if you remember what senings you use here, as when 
you dial in you may need to configure the remote computer accordingly. If you select 
Half Duplex mode , someone looking at your computer screen will see everything the 
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remote user sees except when the CLI is in use. If you select Full Duplex, STalker will 
not show anything in the terminal window except modem commands and responses. 

Click the mouse on the words CLI Shell Program (click ro change) and the GEM 
file selector will appear. Choose a TOS based CLI program and its name will appear in 
the dialog. This CLI program can be run if you call into your system and know the CLI 
password. Only CLI programs that support redirection will work, such as rhe public 
domain CLI on rhe STalker disk. 

Note: If you are accidently disconnected while using the CLI, you will nor be able ro 
log back in. 

If you left-click in the box nexr ro the words Bypass System Error Handler, you 
can turn off the dialog boxes rhar normally pop up on your Arari's screen when you have 
a bad disk, write protect error, ere. As these boxes freeze the system until rhe problem is 
corrected, and you would be some distance away at the remote computer, rhis can save 
you from being locked our of your system in rhe event of an error. 

The Baud Rates to Use burtons allow you ro choose which baud rates you can use 
when calling in. You must choose ar least one speed before you can enter remote mode. 

If you exir rhe Remote Mode Settings box wirh rhe OK burton, changes you made to 
rhe box will take effect, but rhe system will nor enter remote mode. If you exit via rhe 
Cancel burton, any changes you made will be ignored and the box will return to its pre­
vious stare. If you exit via rhe Remote Mode burton, the system will enter remote mode 
and start waiting for an incoming call. Before you leave, be sure your modem is turned 
on. To exit remote mode, press the [Undo) key. 

When you dial in, you will be greeted with "Hit Return" messages until you type 
[Return). (Wair for rhis, as STalker cycles through rhe baud rates.) After entering rhe 
password, you will see the prompt "Command?" . Type "?" for a list of commands. 
Commands are available ro choose a directory, list rhe files in ir, upload or download 
files, run rhe CLI program, and log off. There is also a Chat Mode, in which you and a 
person ar your computer can type messages to each other. 

Remote mode is actually run by a BackTALK script called REMOTE .BTK, located 
in the script directory (see Preference Settings for details .) Therefore, the script directory 
must be set properly in order for remote mode to work. If you want to try out Remote 
Mode wirhour actually dialing in, use Communication Sertings ... on the Sertings menu 
to set your mode to 'Local', then execute the REMOTE.BTK script by using Run Back­
TALK Script ... from the Back TALK menu. If you are told your script buffer is not big 
enough, use Preference Settings to increase irs size. You will have to save your sertings 
and reboot to reload the accessory, or reload the STalker program, for the change to cake 
effect. 
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7.2.10. Shadow access... [Alt][=] 

If you own the Shadow background file 
transfer utility from Double Click Software, you 
can use STalker to interface with the Shadow 
driver, rather than using the desk accessory sup­
plied on the Shadow disk. You can still use 
STalker's file transfer routines if you wish; it 's 
your choice. 

tonfiguration file,,, 
Save tonfiguration 006 
Save tonfiguration as,,, «~6 

Send text fi 1 e, , , :•JS 
Reteive text file,,, WR 
Upload binary file,,, oou 
Do~o~nload binary file.,, .:•JD 

If Shadow is loaded, the Shadow Access... ---------------------------------
Invoke STeno~ OOTab 

command will be enabled. This will present you ReMote. (M j n 1 -BBS) MOde, , , :•JB 
with one of two dialog boxes similar to the ones 
used by the Shadow Desk accessory. The first 
box allows you to start a Shadow upload I down­

----~ ~~---~--~---------·~--------
Close ~indoH 000 

load, and the second allows you to monitor the status of a transfer and abort it if 
necessary. 

7 .2.11. Quit/Close window [Alt] [ Q] 

As a GEM program 

When run as a GEM program, this option 
will exit STalker and return you to the desktop. 
It will only say Quit. If you are in the middle of 
a file transfer operation, you will not be allowed 
to exit until the transfer finishes or is aborted. 

As a desk accessory 

Open tonfiguration file.,, 
Save tonfiguration 006 
Save tonfiguration as,,, ~l6 

Send text file,,, :•JS 
Reteive text file,,, OOR 
Upload binary file... OOU 
Do~o~nload binary file.,, OOD 

Invoke STeno~ WTab 
ReMote (Mini-BBS) MOde,,, WB 

When run as a desk accessory, this option Shado~o~ '" attcss, , , :+:= 
closes the STalker window. It will only say --------------------------------­
Close window. As · STalker operates in the 
background when used as a desk accessory, the 

Close WindoH WO 

only thing this command does is remove the STalker window from the screen. You are 
not disconnected from the host system, and any data transfer operation in progress will 
conti nue. To reopen the STalker window, choose STalker from the Desk or Atari Fuji 
menu. 

40 



Gribnif Software Drop-Down Menus and Dialog Boxes 

7 .3. Edit Drop-Down Menu 

7.3.1. Abort current operation 
[Undo] 

This command lets you stop any operation 
in progress. This includes file transfer operations 
and remote mode. You can also press the [Undo] 
key on the keyboard. 

Copy window to clipboard OOC 
Paste clipboard ltextl ~U 
Paste clipboard (binary) <;(•:u 

Clear window contents AClr 

Some operations, like an autologin sequence, actually consist of multiple steps. 
Pressing [Undo] will cancel just the current step. To abort the entire operation press 
[Shift][Undo). 

7.3.2. Copy window to clipboard [Alt][C] 

This command copies the visible contents of 
the window {not the entire virtual screen) to 
STalker's invisible text clipboard, erasing any 
text already in the clipboard. If you wish to ap­
pend to text already in the clipboard, define a 
block and use the Append to Clipboard command 
from the Block Action Window. 

7.3.3. Paste clipboard (text) [Alt][V] 

This command uploads the contents of the 
clipboard to the host system as text. It is similar 
to the Send Text File... command on the File 
menu, but sends text from the clipboard rather 
than from a disk file. 

Clear window contents AClr 

current operation 

Clear window contents AClr 

7.3.4. Paste clipboard (binary) [Alt][Shift] M 
This command uploads the contents of the 

clipboard to the host system, using the Binary 
File Transfer Protocol and settings currently in 
effect. Before issuing this command, you should 
tell your host system to prepare for a binary 
upload. 

current operation Undo 

Clear window contents AClr 

41 



STalked 

7.3.5. Clear window contents [Control][Clr/Home] 

This command erases the entire virtual 
screen, not just the text that is visible within the 
window. 

operation Undo 

Copy HindoH to clipboard roc 
Paste clipboard (text) OOU 
Paste clipboard (binary) ~JU 

Clear windoH contents AClr 

7 .4. Settings Drop-Down Menu 

7 .4.1. Communications settings... [Alt][P] 

This option displays the Communication Set­
tings Dialog Box. You can set the baud rate, 
echo mode (duplex), flow control, parity, word 
length, and stop bits by left-clicking on the ap­
propriate set of radio buttons. See the !ntro to 
Telecommunications chapter for information on 
these settings. 

------- Current Servite --------
.iiiTi~ !R 

File transfer settings.,, OOX ~ 
TerMinal settings... OOT 

------- Global Settings -------­
CoMMunication port.,, «~P 
Function key settings ... OOF 
ModeM settings .. , ~JM 
Preference settinas .. , OOV 

STalker~ CoMMUnitation Settings 

Baud Rate: 2400 

Mode: U!'III,JTT!1U:d Echo (Half Duplex) Ill local I 

FloH Contro.l: I None d3'1:tj:)l!jb RTS/CTS Ill Both I 

Parity: ~1 (Mark) drlf'ii£101 

Word length: IB BitsN;OM 6 Bits m 5 Bits I 

Stop Bits: -~ M 1.5 - 2 

[][] !Change A 111 IL...-_...::C;.:.:;ha::..:.;n~ge::.......::..Of.:....:f....;-L::..:i..:..:.;ne=----...J I Cancel I 

There are 4 ways to exit from this dialog box. The OK button puts the changes you 
made to the box into effect until you change them again or dial using the Autodialer 
menu. The Change All button puts the changes into effect and copies them to all en­
tries in the Autodialer. (Each of the 30 entries in the autodialer not only stores a phone 
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number, but a complete and independent set of parameters; see Autodialer Directory for 
more information.) If you have used the Autodialer to call a system, the Change 
(name) button changes only the Autodialer entry you are using to reflect the new pa­
rameters. Finally, the Cancel button exits the dialog box and ignores all changes. 

7.4.2. File transfer settings... [Alt][X] 

The File Transfor Settings dialog box, dis­
played by invoking this command, lets you set 
the parameters for both text and binary uploads 
and downloads. The top half of the box deals 
with text uploads and downloads, while the bot­
tom half deals with binary file protocols. 

------- Current Service -------­
Co~~unitation settinas ... OOP 

TerMinal settings... t+JT ~ 
------- Global Settings -------­

CoMMunication port... «~P 
funttion key settings ... Mf 
ModeM settings, , , t+JH 
Preferente settinos,.. MY 

STalker~ File Transfer Settings 

Text (ASCII) File Transfers 
DOWNLOADS UPLOADS 

Line ~ait ClOths of a set): 
Host proApt string: 

0~-Add linefeeds after CRs: [] 

BOTH Expand blank lines as: 
Strip linefeeds: AZ Aarks end of file: [] -. 

Binar File Transfers 
Prototol: XModeA Auto-start ZM/B-Plus transfers: II 

* PROTOCOL-SPECIFIC SETTINGS * 
FilenaAes: 
Subdirs: 

There are 4 ways to exit from this dialog box. The OK button puts the changes you 
made to the box into effect until you change them again or dial with the Autodialer 
menu. The Change All button puts the changes into effect and copies them to all en­
tries in the Autodialer. If you have used the Autodialer to call a system, the Change 
(name) button changes only the Autodialer entry you are using to reflect the new set­
tings. The Cancel button exits the dialog box and ignores all changes. 

7.4.2.1. Text settings 

The button labelled Add linefeeds after CRs, when turned on, causes all Carriage 
Return characters received in a text download to have Linefeed characters added after 
them before the file is saved. This is useful because many text editing programs expect 
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each line in a text file to end with a CR/Linefeed combination. Most systems already 
send the CR/Linefeed combination, so this option can usually be turned off. 

The "Z (Control Z) marks end of file option, when turned on, causes STalker to 
add a "Z marker to the end of the newly saved text file when the Receive Text File ... com­
mand is terminated. In Send Text File ... with this option on , STalker uses "Z as an end­
of-file marker and will therefore stop transmitting when it encounters a "Z. With this 
option off, STalker transmits until the physical end of the file. 

The Line wait text field lets you enter a number which is used to pause uploads at 
the end of each line. The number is in I Oths of a second, so a 10 in this field would 
cause a pause of one second between transmission of each line. Use this function if your 
host computer needs extra processing time before it is ready to receive the next line. 

Host prompt string is dependent on your host system; check with your host system 
to see what, if anything, to enter in this field. When sending a text file, STalker will 
wait up to 30 seconds for the specified Host Prompt String to be received before sending 
the next line of text. If it appears that the Host Prompt String is not coming, you can 
abort the wait by pressing the [Undo] key. [Shift][Undo) or Abort Current Operation 
from the Edit menu aborts the entire file transfer command. If you have a Line Wait as 
well as a Host Prompt String, STalker will first wait for the string and then pause for the 
line wait. 

The Expand blank lines as text field lets you enter characters which will be trans­
mitted in place of any blank lines in your upload file. This is useful because many BBS 
text editors exit the editor upon receipt of a blank line. If you are trying to send text 
containing blank lines into an editor of this type, you can use the Expand Blank Lines 
field to substitute a space for each blank line. This will enable you to send your file 
without any problems. 

Finally, the Strip linefeeds option will remove linefeeds from your file's transmis­
sion. Carriage Return/Linefeed combinations will therefore be transmitted as Carriage 
Returns alone. 

7.4.2.2. Binary File protocol settings 

The Protocol burton lets you select which Binary File Protocol you will use for fu­
ture uploads. Left-click on the button to pop up the protocol menu, then left-click on 
the protocol you want. 

Note: If any new protocols have been added to STalker since this manual was written, 
they will be added to the protocol buttons in this dialog box. See the 
README.NOW file on the program disk for information, if necessary. 

When downloading, STalker can usually detect which protocol the host computer 
is using. However, if STalker is set for YModem-G it will not be able to detect any oth­
er protocol. 
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The XIYModem ... and ZModem ... buttons pop up dialog boxes which enable you 
to set up parameters for X,Y, and ZModem. Generally, the default settings work. If 
they don't, check with the system you are calling to see what the correct settings are. 
These boxes are explained on the next page. 

YModem and ZModem can be used for batch uploads, as explained in the Binary 
Upload ... menu option. Because they can transmit several files in sequence, YModem 
and ZModem send the filename along with the file. The Filenames group of radio bur­
tons lets you control how the filename is sent. File sends just the filename with no sub­
directory information. Relative adds subdirectories below the starting subdirectory, and 
Full sends the complete pathname (except the drive letter, which is never sent). For ex­
ample, if your upload request path was for C:\TELECOMM\*.* and the current file being 
uploaded was C:\TELECOMM\DIR\INFO.TXT, you would send the following: 

FILE: info.txt 
RELATIVE: dir/info.txt 
FULL: telecomm/dir/info.txt 

The Subdirs group of radio buttons lets you control how subdirectories are handled 
when doing a batch upload. None means do not look in subdirectories; rather, only 
send files in the requested directory. Match means to look in all subdirectories for files 
that match the requested template. '• .*' means to send all files in all subdirectories. 

The Auto-start ZM/B-Pius transfers button controls whether or not STalker auto­
matically begins a ZModem upload/download upon receipt of the special string indicat­
ing a ZModem up/download (**11XBO). A similar string is also detected for CompuServe 
B-Plus file transfers. 

7.4.2.3. Setting XJY/ZModem Upload/Download Parameters 

In the XIYModem Parameters box, click on the appropriate button to turn the two 
options on or off. Normally, both the options may be off. 

STalker~ X/YModeM ParaMeters 

Relaxed TiMing (use this Hith sloH hosts):[] 
(ALSO USEFUL HITH HIGH-SPEED MODEMS AT LOH SPEEDS) 

Pad the last blotk Hith a •size• byte: [] 
(NOT USED HITH XHOOEH-1K OR VHODEH-BATCH) 

OK Cantel 
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The ZModem Settings box contains a number of buttons which let you set the pa­
rameters for ZModem uploads and downloads. 

ZHodeM Upload Settings 

Options: None spetified 

Transfer Mode: E -lli!.lii.Ji!Mm! BINARY 11 TExT 

Use 16 bit CRCs (off Means use 32 bit CRCs): 

ZModeM Download Settings 

Options: 

Transfer Mode: 

I 
D 

Estape (entode for transMission) all ttrl thars: D 
't LOWERS THROUGHPUT SLIGHTLY, BUT IS NECESSARY HITH SOHE HOSTS 1' 

OK Cantel 

The two Options buttons pop up a menu of choices as follows: 
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None specified: Use whatever option , if any, the host system specifies. Unless you 
choose this option, STalker will override the host system's specified option with its 
own. 

Transfer if source is newer or longer: send the file only if the destination file does 
not exist, or has a timestamp or length less than the source file. 

Transfer if size/date/content differs: send the file only if the destination file does 
not exist, or has a timestamp or length different than the source file. If the time­
stamp or length matches, the receiver should request that the sender compute a 
32-bit CRC on the files to see if they are the same. If they are not, the file is trans­
mitted. Nqte that many ZModem implementations do not support the CRC sec­
tion of this option . 

Append: Append the contents of the source fil e to the destination file, creating the 
destination file if it does not exist. 

Overwrite: Delete the destination file, then transfer the file. 

Transmit only if source newer: Send the file only if the destination file either does 
not exist or has a timestamp 'older' than the source file. 

Don't overwrite: Do not transfer the file if a file of the same name already exists on 
the destination machine. 
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The Transfer Mode button groups control whether ZModem text or Binary is used. 
In ZModem binary mode, the file is sent exactly as it is, byte for byte. In ZModem text 
mode, the sender does whatever translation is required to change end-of-line markers 
within files to be transferred between computers that use different methods for marki ng 
the end of a line. Files to be transferred via ZModem Text must contain only printable 
ASCII characters (from ASCII 33 to 126, plus spaces, tabs, backspaces, LF' s and CR's). 

You can usually leave the Transfer Mode buttons sec to Automatic and Sender Picks. 
STalker can usually pick the correct mode so it is not necessary to specify which one to 
use under normal circumstances. 

If STalker is receiving in ZModem Text mode, it will convert single Line feeds into 
CRILF pairs. Due to the face that the file is being modified as it is received , files sent in 
Text Mode cannot have an aborted transmission resumed. 

The Use 16 bit CRC's button lets you choose between 16 and 32 bit CRC's. 
When on, you will get 16 bit CRC's, when off, 32 bit. You should generally leave this 
button off, as 32 bit CRC's are more reliable. 

The Escape All Control Characters burton causes all 7 and 8 bit control characters 
to be 'escaped' (preceeded with an Escape sequence). This slows down transfer speed 
bur is sometimes the only way to transfer binaty files over systems that try to process 
control characters. 

7 .4.3. Terminal settings... [Alt] [T] 

The Terminal Settings dialog box , which ap­
pears when you invoke this command, lets you 
choose which of STalker's three terminal emula­
tion modes you wish to use - VT52, VTI 00 , or 
PC-ANSI. You can also set various parameters 
related to the emulation. Check with your host 
system for information on how to set these op­
tions correctly, as proper settings vary from sys­
tem to system. 

------- Current Servite -------­
CoMMunitation settings.,, ~p 
file transfer settings ... ~X -· ' ... ------- Global Settings ------ ·~ 
CoMMunitation port... ~~P 
funttion key settings... ~f 
ModeM settings,,, ~M 
Preferente settings... ~Y 

The buttons on the left work for all terminal modes. The Application Mode Key­
pad button controls whether using the keypad sends numbers or control sequences. 
Line wrap controls whether long lines are wrapped or truncated. On the right, Appl. 
Mode Cursor Keys controls the codes sent by the cursor keypad. Insert Characters 
Mode is an advanced mode that lets characters be inserted into a line. Newline Mode 
causes a Return to transmit a Rerurn/Linefeed, and moves the cursor to the beginning of 
a new line when you receive a linefeed. Swap Backspace and Delete reverses the fun c­
tions 6f these two keys on the keyboard; it is primarily designed to facilitate connecting 
to Digital VAX systems. 
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If you have GDOS loaded, the Font To Use For Terminal button will allow you to 
select a GDOS font. Use the Point Size text field to select a size. The IBM Character 
Set button controls whether the current font uses the IBM or Atari Character set. See 
the Technical Information section for more information on these features. 

STalker~ TerMinal EMulation Settings 
TEIItMlNAL. TYPE TO EHULATE 

··•- 'IZ'-I'-!I'I··Itfl.lllit(=~OE~C~V~T~t0~0=JIMI IBM PC-ANSI 

ALL EMUUHIONS l 

Applitation Mode Keypad: 
Cursor Hidden: 
Cursor Blink: 
Line Wrap: 

PC -~SI & VT100 EMULATIONS ONLV : 

Appl, Mode Cursor Keys: ~ 
Insert Charatters Mode: 
NeHLine Mode: · 
SHap Batkspate & Delete: 

font To Use for TerMinal: Systen fo nt I 
font Uses The IBM Charatter Set (Off = Atari font)? [] 
Point Size for TerMinal font: 1~ 

OK I !Change All I Change Off-Line I Cantel I 

There are 4 ways to exit from this dialog box. The OK button puts the changes you 
made to the box into effect until you change them again or dial using the Autodialer 
menu. The Change All button puts the changes into effect and copies them to all en­
tries in the Autodialer. If you have used the Autodialer to call a system, the Change 
(name) button changes only the Autodialer entry you are using to reflect the new pa­
rameters. Finally, the Cancel button exits the dialog box and eliminates all changes. 

7.4.4. Communication port... [Shift] [Alt] [P] 

This option lets· you choose the port to 
which your modem is connected. STalker can 
support any of the ports on the Mega STe and 
TI/030, plus Double Click Sofrware's DC-Port, 
Gadgets by Small's MegaTalk, and Beckemeyer's 
simulation of multiple ports in sofrware. Left­
click on the name of the port you want to use. 

If you have an ST/TI with more than one 

------- Current Service -------­
CoMMunitation settings,,, OOP 
file transfer settings ... OOX 
TerMinal settings,,, OOT 

------- Global Settings -------­
t:ot!l!l 

funttion key settings,,, OOf 
ModeM settings... OOM 
Preferente settinos.,, OOV 

port, and you have multiple modems, it is possible to keep multiple copies of STalker in 
memory, each one talking to a different port/modem combination. In addition, if you 
own STeno, you can keep multiple copies of that program in memory and have each 
copy of STeno "attached" to a different copy of STalker. See the chapter entitled Keep­
ing Multiple Copies of STalker and STeno in memory for further information. The Con­
trol Settings columns tell you which ports support which signals. 
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STalker~ CoMMunitation Port 

Port NaMe Control Si nals 
FLOH OCO OTR B~EFUC: 

Serial Port J J J J 
Midi Port 
Printer Port (Write-Only) 
TT Serial 1 Port 
TT/MSTe Serial 2 Port 
TT/MSTe ModeM 2 Port 
Double-Clitk DC -Port ~1 
Double-Clitk DC-Port ~Z 
MegaTalk Port R 
MegaTalk Port B 
Betkeneyer MT C-Shell ttyp8 
Betkeneyer MT C-Shell ttyp1 
Betkeneyer MT C-Shell ttyp2 
Betkene er MT C-Shell tt 3 

XOH .j 

XON .; .; .; 
..; ..; ..; ..; 

XOH .j .j .j 

XOH .j .j .j 

XOH .j .j .j 

XOH .j .j .j 

OK I Cantel I 

7.4.5. Function key settings... [Alt][F] 

This option brings up a dialog box which 
allows you to program the function keys ([F1) 
through [F1 OJ) so that when you press them, 
they transmit a message of your choice to the 
host computer. There are 20 text fields in the 
dialog box, allowing individual programming of 
keys [F1) through [F10) and [Shift][F1] through · 
[Shift][F1 OJ . Once the function keys are pro­
grammed, press the appropriate key, or [Shift] 
and that key, to transmit your message. 

------- Current Servi t e -------­
CoMMunitation settings.,, OOP 
file transfer settings .. , OOX 
TerMinal settings,,, OOT 

------- Global Settings -------­
CoMMunitation port.,, ~·:p 

-; ,. 
Moden settings... MH 
Preferente settinas,,, OOV 

To program in a I /2 second delay at any point in the transmission of the message, 
use the [Insert] key on the keyboard. The symbol "y,'' will appear to indicate the pause. 

If your desired message does not fit in the text field allowed for each function key, 
you can chain the keys together. This means that STalker can send another key's mes­
sage at any point within the first key's message To use chaining, at any point in the text 
field type the [Cir/Home) key (the symbol "f" will appear) followed by an f-key number 
from I to 20. I to I 0 represent the ten function keys, while II through 20 represent 
the keys plus the [Shift) key. Do not put a space between the "f" and the number. 
When the function key's message is sent, the f# code will be substituted by the chained 
function key's message. You can chain keys within already chained keys ("nesting"). If, 
for example, you wanted to send function key I followed by the number 7 y

1
ou would 

need to enter "/017", as "f17" would be interpreted as function key 17. 
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STalker~ Funttion Key Settings 
F 1 
F 2 
F 3 
F 4 
F 5 
F 6 
F 7 
f 8 
F 9 
FlO 

Mail ~----------------------------------- PRESS THE 'INSERT" KEV TO This Message is too long to fit into f3_ 
ADO A V2 SECOND OE L.AV 

one funttion key! ~---------------------
§Login.btk------------------------------ THE 'HOME" KEY IS USED TO 

---------------------------------------- TO INVOKE BACKTAL.k• SCRIPTS 

Of 1 
Of 2 
Of 3 
Of 4 
Of 5 
Of 6 
Of 7 
Of 8 
Of 9 
Of10 

"Of" inditates a shifted funttion key. ~ 

---------------------------------------- ~LEIIISE JtE,.-EJt TO THE STI'\LKER 

Hf'IINUf"'L. ,.-gJt HOltE IN,.-OitMI'IITION 

I Load ... I I Save ... I 

OK I I Cantel I 

If your message requires a significant portion of the available function keys, you 
may find it more efficient to write a BackTALK script rather than programming the 
keys. To cause a function key to invoke a Back TALK script, place the cursor in the field 
of the key you want to program, then press [Shift][Cir/Home] . A"§" symbol will appear 
in the field. Then , put the name of the Back TALK script you wish to run. Note that 
the directory in which Back TALK scripts are located is set using the Preference Settings ... 
command on the Settings menu. 

The Load .. . and Save ... buttons bring up the GEM file selector so you can load and 
save your function key settings. Do not forget to save after editing. If you exit STalker 
without saving, you will lose all your work! Save Configuration ... will cause your keys to 
be loaded automatically. 

The OK button exits the dialog box and implements your changes. The Cancel 
button exits the box and ignores all changes. 

7.4.6. Modem Settings... [Alt] [M] 

This option displ ays a dialog box which 
lets you configure your modem settings. If you 
are using a Hayes compatible modem, you 
should not need to change anything in this dia­
log box. There is only one exception: if you do 
not have Touch Tone dialing, change the PRE­
FIX text field from "ATDT " (tone) to "ATOP" 
(pulse). 
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CoMMunitation settings .. , WP 
file transfer settings ... WX 
TerMinal settings... WT 

------- Global Settings -------­
CoMMunitation port.,, «~P 
funt t ion key settings. , . :+Jf 

.iloo:.[wl 

Preferente settings, , . :•JY ~ 
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STalker~ ModeM Settings 

Dialin 
ModeM Init: RTX4~~---------

Prefix: RTDT __________ _ 
Suffix: 'i. ___ _ 

Delay betHeen chars: 10_ 
t TIMING f"'OIIt MOCEH COMMANDS t 

IN II' 100ths: OF A SECOND 

Han in U 
Drop DTR: II 
Send: >;>;>;+++>;>;~ATH!·------

~ INSERT• ADOS A U 'Z SEC. DELAY 

OK 

Detettin Connection 
HodeM Sets DCD Properly: II 

Connett 1: COHHECT ___ _ 

Connett 2: -----------

failure 1: HO CARRIER_ 
failure 2: HO DIALTOHE 
failure 3: BUSV ______ _ 
failure 4: ERROR _____ _ 

STALKER,. WILL. HAlT FOR ONE OF THE 

A80V E STRINGS T O BE RECEIVED IF 

.. MODEM SETS OCO .. IS NOT SELECTED 

I Cancel 

If you are not using a Hayes compatible modem, consult your modem manual to 
determine the correct settings are for the entries in this dialog box. 

The options in the Dialing section of the dialog box allow you to configure STalk­
er's autodialer to work with your modem. The Modem lnit text field is sent to the mo­
dem each time the autodialer dials. Next, STalker sends the Prefix field' s text, followed 
by the number programmed into the autodialer, and finally, the text in the Suffix string. 
Carriage Returns are displayed as a small "c/r", and are entered with [Controi](M]. If you 
don't have enough space, you can use function key chaining in these fields. If you leave 
both Prefix and Suffix strings empty, STalker will assume you are using a manual-dial 
modem, and will display an alert box instructing you to dial the telephone. 

If you find that STalker doesn't seem to be able to dial properly, then it' s possible 
that your modem isn't handling the DCD (Data Carrier Detect) line correctly, as 
STalker normally monitors this line to determine if a dialing attempt was successful. 
This can be solved either by changing your modem settings (if you have a Hayes­
compatible modem, send it the "AT&C1" command, then save the new configuration) 
or by left-clicking in the Modem sets DCD properly box to turn it off. When DCD 
handling is off, STalker will examine the modem's responses for one of the success 
(connect 1 and 2) or failure text fields. Enter the data into these fields according to 
your modem's manual. 

STalker also uses the RS-232 DTR (Data Terminal Ready) signal in order to hang 
up the phone line. Make sure that your modem is not ignoring the DTR signal or the 
Hang-up phone line command will not work. For Hayes compatible modems, this is 
accomplished with the "AT&D1" command. If your modem is not Hayes compatible, 
consult your modem manual. If your modem will not hang up when the DTR signal is 
dropped, left-click on the Drop DTR box to turn it off; this will cause STalker to send 
the text in the field directly under the button rather than dropping the DTR signal 
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when you issue a hang-up command. Consult your modem manual to see what to enter 
in this field. You can use function key chaining as previously described. 

The OK button exits the dialog box and implements your changes. The Cancel 
button exits and ignores any changes. After changing the settings , use Save Configura­
tion from the File menu to save your changes. 

7.4.7. Preference Settings... [Alt] [Y] 

The Preference Settings dialog box lets 
you change various settings . After making any 
changes to this box, save your configuration to 
make the changes permanent. 

------- Current Service -------­
CoMMunitation settings ... OOP 
file transfer settings •. , OOX 
TerMinal settings... OOT 

The first two text fields, Number of lines in 
scrollback buffer and Number of columns in 
scrollback buffer, let you set the size of the 
virtual screen. The larger the numbers you en­
ter here, the more memory STalker will use. 

------- 6lobal Settings -------­
CoMMunitation port... «~P 
funttion key settings,,, OOf 
ModeM settings,.. :•JM 

-~ · · · Ill' 

The File Transfer Buffer Size sets the size of the buffer (memory area) STalker uses 
when doing uploads and downloads. Increasing the size of the buffer reduces the num­
ber of disk accesses STalker will make during a file transfer operation. Buffer size is not 
overly important for hard disk owners since hard disk I/0 is so fast . Floppy users will 
need to experiment to find a value that balances the frequency of disk access with the 
time required for each access. Too large a buffer may result in retries during downloads 
if the time required to save or load the buffer is too long. 
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STalker~ Preferente Settings 

NuMber of lines in strollbatk buffer 
NuMber of toluMns in strollbatk buffer 
file transfer buffer size 
BatkTALK~ stript buffer size 

(74-~~~~): 
(40-200) 

(4-127) : 
(1-64) 

1' CHANGES WILL ONLY Tf'ltcE EFFECT AFTER RE-STARTING STALKER"' t 

240~ 
80_ 
4--K 

16K 

ReMove transfer status HindoH 3 __ sets. after toMpletion 
Clipboard drive: C WindoH/ACC prefix : Stalker: __ 
STeno~ naMe : STENO NuMber of Minutes ± GMT: -300_ 

t N .v . IS -300., lof'l o -480,. BERLIN 60 t 

~ DoHnload direttory Ctlitk to thange) ~ 

~ *.BTK stript direttory (tlitk to thange) ~ 

Destruttive batkspate 
Keep aborted doHnloads 
Sounds 

OK 

C 1' •• &TIC 

favour tonturrenty § 
7-Bit extended ASCII 
Use GDOS Monospated fonts 

t GOOS CHANGES REQUIRE A RE-800T t 

I Cantel I 
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BackTALK Script Buffer Size lets you set the maximum size for a script. 

Note: After changing any of these four fields, you must save your configuration and 
restart STalker for the changes to rake effect. 

The Remove Transfer Status Window text field lets you enter a number which de­
termines how long the status box displayed during a file transfer operation stays on the 
screen after the transfer completes. 

The Clipboard Drive field lees you choose the drive to which STalker writes the 
temporary data files (SCRAP.TXT) used by the clipboard. 

Note: If the drive letter Z is entered in the field, STalker will use rhe new Acari 
standard method for accessing the clipboard. Note that some older programs 
(including STeno 2.00) are not aware of chis method, and may experience 
difficulty when trying to Paste text which was written by STalker when drive Z is 
used. 

The Window/ACC Prefix field lets you customize the name which is displayed in 
the Desk Accessories list and at the top of the window for this copy of STalker. Since it 
is possible to have more than one copy of STalker in memory at a time , each one con­
nected to a different port/modem combination, this option lets you determine which 
copy is which by giving each copy of STalker a unique name. 

The STeno Name field lets you enter the program name under which STeno is 
running. Normally, this will be STENO. However, if you are running multiple copies 
of STalker, you may also wish to have multiple copies of STeno as well. (See Keeping 
Multiple Copies of STalker and STeno in memory for details.) Each copy of STeno 
will be run using a unique filename (such as STEN01 .ACC, STEN02.ACC, etc), and 
you should enter into the STeno Name field the filename of the particular copy of STe­
no you want to associate with this particular copy of STalker. 

Enter into the Number of Minutes +- GMT field the number of minutes that your 
timezone is offset from GMT (Greenwich Mean Time, also called Universal Coordi­
nated Time). In the United States, Eastern Standard Time is -300, Central Time is 
-360, Mountain Time is -420, and Pacific Time is -480. Berlin, Germany, is +60. This 
number is used to correct timestamps in YModem and ZModem transfers. See the 
Technical information chapter for further details on timestamps. 

The Download Directory lets you set the default path for downloads (that is, the 
path initially displayed in the GEM file selector when you issue a download command). 
This path is also used when a ZModem transfer initiates automatically. To change this 
setting, left-click anywhere on the words Download Directory. The GEM file selector 
will appear. Choose the path you want, then exit with the OK button. 

The *.BTK Script Directory function lets you set the default path for BackTALK 
scripts (that is, the place in which STalker looks for BackTALK scripts). To change this 
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setting, left-click anywhere on the words *.BTK Script Directory. The GEM file selector 
will appear. Choose the path you want, then exit with the OK button . 

If you elect to Keep Aborted Downloads, any data received before a download is 
aborted will be kept. Normally, this option is off and the data is only kept upon 
successful completion of the download . In order to use the GDOS Monospaced Fonts 
option, you must have GDOS or a compatible program loaded. Fonts are supplied on 
the STalker 3 disk. If you are running STalker as a desk accessory, you mus turn this 
option on, save the configuration, and chen reboot the computer before STalker will al­
low GDOS fonts to be used. 

If 7-bit Extended ASCII is selected, a SHIFT-OUT (Control N) character cells 
STalker to interpret subsequent characters as extended ASCII codes until a SHIFT-IN 
(control 0) is received. If chis option is not selected, SHIFT-IN and SHIFT-OUT are 
ignored. If you receive a spurious SHIFT-IN with this option on and start seeing 
strange characters, you can return to normal by pressing [Ait][Esc] . This option only af­
fects VTI 00 and PC-ANSI emulation modes. 

The Sounds buttons control the sound effects used by STalker. On plays the full 
range of tunes. Bell gives you a simple tone. Off causes STalker to briefly invert the 
menu bar instead of making a sound. This setting affects the "Pl ay_Sound ()" Back­
TALK routine similarly. 

The Favour Concurrency option causes STalker to look for GEM events more of­
ten than normal during binary file transfers. This slows down file transfer speed slight­
ly, while improving the system's response time to GEM events. When this option is off 
and a baud rare of 9600 or greater is being used, very few GEM events will occur. This 
is so that the maximum throughput can be achieved. 

7 .5. Options Drop-Down Menu 
All the entries on the Options menu may be toggled on and off by selecting them. 

When an option is turned on, a check-mark will appear in the menu to the right of that 
option. 

7.5.1. Capture Mode [Alt][O] 

This option is only available if STeno is 
loaded. When capture mode is on, incoming 
text is sent to STeno, which appends it to the 
file being edited. This mode is indicated by a 
black dot which appears to the left of the 
window title text. See the Technical Informa­
tion chapter for further information. 
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---------- Window Style ----------
J Horizontal stroll bar 00-
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J Title bar t•:~ 
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7.5.2. Echo Typed Characters [Alt][E] 

This opcion coggles becween Full and 
Half Duplex. When chis opcion is curned on, 
you are in Half Duplex mode, when off, Full 
Duplex. This opcion does che same ching as 
opening che Communication Settings dialog 
box and changing che Full/Half Duplex hue­
cons. If you change che senings usi ng che dia­
log box, che Echo Typed Characters menu 
opcion will change accordingly, from checked 
co unchecked or vice versa. Similarly, if you 
change che senings using che menu, che dialog 
box senings will change. 

7.5.3. Disable STalker [Alt][K] 

This opcion disables STalker, prevencing 
ic from sending or receiving daca. To curn 
STalker back on, choose chis opcion again. 
When STalker is disabled, you will noc be 
able co execuce any commands having co do 
wich sending or receiving daca. This opcion 
is useful if you wane co run anocher GEM 
based communicacions program while 
STalker is loaded, as ic scops STalker from 
reading daca from che communicacions pore. 

Capture Mode ~JO 

Disable STalker "~' ~JK 
Reset tOMMunitation port OOEst 
Send a BREAK signal OOBksp 
Send text to printer OOL 
Show tontrol tharatters OORet 

---------- ~ indow Style ----------
J Horizontal stroll bar oo-
J Uertital stroll bar 001 
J Title bar oo~ 

.I •lt!•Il._ .. 

Capture Mode 000 
Etho typed tharatters OOE 

-IJI-'f; oJ1 .. 1r:l . . ~---
Reset tOMMunitation port :•JEst 
Send a BREAK signal OOBksp 
Send text to printer OOL 
Show control tharatters OORet 

---------- ~indow Style ----------
J Horizontal stroll bar 00-
1 Uertital stroll bar 001 
J Title bar oo~ 

7.5.4. Reset Communication Port [Alt][Esc] 

This command resecs che currenc com­
municacions pore. This is helpful if che pore 
locks up, someching chac happens more fre­
quendy on TOS 1.0 and 1.2 based machines. 
See che Technical Information chapcer for fur­
cher decails. 

., •J.tll 1 .... 

Capture Mode 000 
Etho typed characters OOE 
Disable STalker~ OOK 

•=·. '''*~~ 
Send a BREAK signal "~' t•JBksp 
Send text to printer ~l 
Show control tharatters ~Ret 

---------- ~indow Style ----------
J Horizontal stroll bar ~-
J Uertital stroll bar ~I 
I Title bar oo~ 
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This command transmits a BREAK sig­
nal. Some systems use chis special signal to 

stop certain operations. You can also use 
[Controi)[Undo] to send a BREAK signal. 

7.5.6. Send Text to Printer [Alt][L] 

When on, chis option echoes any text to 

your printer as it is received. Control and Es­
cape sequences are filtered out and each line is 
printed after the cursor moves off it. 

This mode is indicated by a doc which 
appears to the right of the window tide text. 

•• lliUOTil: .. 

Capture Mode r•lO 
Etho typed tharatters t+lE 
Disable STalker"' [•JK 
Reset toMMunitation port ~lEst 
Send a BREAK signal [•lBksp 

~'f:rilia' ~:••' 1 I 1-
ShoH tontrol tharatters ~ OORet 

---------- WindoH Style ----------
J Horizontal stroll bar (•l-
J Uertital stroll bar [+ll 
J Title bar [+]"'-' 

7.5.7. Show Control Characters [Alt][Return] 

Terminal emulation uses invisible control 
characters to select colors, move the cursor, 
etc. By turning chis option on, you can see 
these characters. Their appearance will vary 
depending on the curren tly selected font. 
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•• I l HiTIJ."'II 
Capture Mode 
Etho typed tharatters 
Disable STalker"' 
Reset toMMunitation port 
Send a BREAK signal 
Send text to printer 

~1il 1 ••• , •• 

[•lO 
~lE 
[•JK 
~lEst 
~lBksp 
(+ll 

• ••• 
---------- WindoH Style ---------­
J Horizontal stroll bar 
J Uertital stroll bar 
J Title bar 



Gribnif Software Drop-Down Menus and Dialog Boxes 

7.5.8. Window style 

Capture MOde reo 
Etho typed tharatters reE 
Disable STalker~ reK 
Reset tDMMunitation port r•JEst 
Send a BREAK signal reBksp 
Send text to printer reL 
Show tontrol tharatters reRet 

---------- ~ in d oH Style ----------
J Horizontal stroll bar re-

J Ti tie bar 

• Horizontal Scroll Bar [Ait][-] (dash key left of[=]) 

• Vertical Scroll Bar 

• Title Bar 

[Ait][IJ (key under [Delete]) 

[Ait][-] (key nexr to [Backspace]) 

These three options turn the corresponding window border element on or off. A 
check mark displayed to rhe left of the menu option indicates that the element is bei ng 
displayed. Remember that turning off either or both scroll bars will also turn off the re­
size gadget, while turning off the titl e bar will also turn off the close and full size gad­
gets. See the Using STalker chapter for a discussion of window gadgets and ways to 
manipulate the STalker window even when some gadgets are hidden . 

7 .6. Dial Drop-Down Menu 

7.6.1. Autodialer Directory [Alt][A] 

This entry brings up the Autodialer Directory 
dialog · box, which enables you to program up to 30 
entries to be automatically dialed. Each entry con­
tains irs own individual data for system name, phone 
number, communication settings, file transfer set­
tings, etc. 

As only I 0 entries at a time are displayed, use 
the vertical scroll bar on the left side of the dialog 
box to scroll up and down the list of entries. 

The Dial? button on the far left of each Auto-
dialer entry works with the Dial Selected Entries 

0 

entr i es't <X;: A 
Hang-up phone line reH 
Hang-up then d i a 1 nex t <X;:H 
Reset $/ () r 1 ork "<X':$ 

GEnie 
CoMpuServe 
Hike C's Super BBS 
«Uninst all ed groupo 
«Uninst all ed groupo 
«Uninstal led groupo 
«Uninsta lled groupo 
«Uni nstall ed groupo 
«Unins talled groupo 
«Uninstalled rou o 

command from rhe Dial menu or the Dial exit button at the bottom of the box. A 
single left-click puts this entry into the list of entries to be dialed. This choice, displayed 
by making the button light gray (or green for color systems), means that the entJy will 
be removed from the dialing list after a successful connection. A second left-click (not a 
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double click), shown by a black button, also puts this entry into the list, and it stays in 
the list even after a successful connection. A third left-click removes the entry from the 
list. Finally, a double left-click on the button causes this entry to be dialed immediately. 
To interrupt dialing, press the [Undo] key. 

STalker~ Autodial Direttory 
Dial? Systel'l Nar~e Henult Phone Nur~ber $$/Hr Lil'li t 

~ Cor~puServe~-------- 7 1-549-0000 ________ _ 

• 

6Enie ______________ 1 1-581-5854 ________ _ 
Hike C's Super BBS_ 3 1-555-1111 _________ 12.34 56,78 

~- ------------------- - -------------------

Settings 
C T X L S 

C T X L S 

' . 
' . 
' . 

o Dial & de-selett if suttessful 
A i Don't dial Wait 35 setonds for a tonnettion 

Redial the list 3 tir~es 
:•: Dial 

Dial I ._1 _O~K~....JI I Cantel Sort I I Load ... I I Save ... 

In the System Name field , enter the name of the computer or service this dialer 
entry calls. 

The Menu# field holds a number from 0 through 9. corresponding to the 10 entries 
at the bottom of the Dial drop-down menu. When you enter a number into this field , 
the system name will appear in the corresponding entry in the Dial menu, and you can 
dial the entry by selecting it off the menu. If you give multiple entries the same num­
ber, each entry will be dialed in sequence until one answers. 

Enter the complete phone number for the dialer entry into the Phone Number 
field , including !-Area Code if necessary. 

The $$/Hr field can hold the cost per hour of the dialer entry. If you enter a num­
ber into this field , when you are connected STalker will display a "cash clock" showing 
how much you've spent since you logged on. If the service is free, leave this field blank 
and STalker will show you a connect time clock instead. 

The Limit field holds a dollar value. If you enter values into the $$/Hr and Limit 
fields, STalker will give you an audible warning when you exceed your dollar limit. 

The five buttons at the right of each dialer entry control the various settings for that 
entry. In order, these buttons are: 
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T Terminal Emulation Settings 
X File Transfer Settings 
L Auto Logon Sequence 
S Auto-Execute BackTALK Script 
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Each entry in the Autodialer has its own independent settings for each option. 
When you click on one of the buttons, the corresponding dialog box will appear, allow­
ing you to change the settings for that entry. The C, T, and X options bring up dialog 
boxes identical to the ones from the Settings menu, except that they only have OK and 
Cancel exit buttons. Refer to the instructions for the Settings menu for detailed in­
structions on these dialog boxes. Remember that changing the settings in these boxes 
does not change STalker's current settings; the changes you make are only associated 
with the corresponding Autodialer entry, and are implemented only when you autodial 
that entry. 

The L button brings up a dialog box which enables you to enter an Auto-Logon se­
quence. This allows you not on ly to dial automatically, but to log into the host system 
without even touching the keyboard. Examine this box, and you will see eight Host 
Prompt fields, each followed by a "text to respond" with field. STalker uses these fields 
as follows: After a connection is established , STalker waits for the data in the first Host 
Prompt field to be received. When it is, the corresponding Text to respond with data is 
transmitted. STalker then waits for the second host prompt field, and so on. If the 
Host Prompt field is left blank, STalker will immediately respond with the correct 
string. You can insert pauses in each response field and at the beginning of the prompt 
field by pressing the [Insert] key once for each I /2 second delay. Use [Controi][M] to in­
sert carriage returns at the end of each response. Don 'c forget the Returns! 

You only need the "tail end" of each prompt in the Host Prompt field . Don't 
worry if it all doesn't fit. For instance, if the host sends "Password/10?", all you need is 
enough to differentiate this message form others, such as "1 0?" . A single"?" may even 
be enough in some cases. 

The Hide button causes a response field to be hidden upon subsequent views of chis 
dialog box. In addition, a hidden field will not be echoed to the screen, even in half­
duplex mode. This will prevent others who may have access to your computer from 
looking at your passwords. Once a field is hidden, you will never be able to view its 
contents. 

As an example of an Auto-logon sequence, suppose your host computer displayed 
"USER 10?" upon connection , and at this point, you enter "12345" and press return. 
Suppose the computer would then respond with 

USER 10 OK 

ENTER PASSWORD? and you enter here "XYZZY" and press return. 
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Your Auto-logon sequence would look like this: 

1 User ID?_ 
2 Pass~o~ord? 
3 
4 
5 
6 
7 
8 

STalker~ Auto-Logon Sequence 

Text To Res ond With 

1 12345)--r--------------------
2 cHidden~r--------------------
3 
4 
5 
6 
7 
8 

t THE •INSEitT• KEV OIVIES A ti"Z SECOND DELAY t 

Type Control-H to insert a 'Return' 

OK I Cancel I 

When you redisplay this box, XYZZY will be hidden. 

The S box lets you specify a Back TALK script to execute upon login . The script is 
located in the directory specified in the Preference Settings ... dialog box. 

At the bottom of the Autodialer Directory box are rwo text fields. The Wait XX 
seconds for connection, where "XX" is a number in seconds, tells STalker how long to 
wait for a connection before giving up. The Redial the list XX times, where "XX" is a 
number from 0-99, tells STalker how many times to dial the list of selected entries when 
you choose the Dial exit button or Dial Selected Entries ... from the Dial menu. If you 
enter 0 into this field, STalker will continue to dial every entry on the list until one 
answers. 

In the lower right-hand corner of the Autodialer Directory box are three buttons 
which enable you to sort, load, and save your work. The Load ... and Save ... buttons 
display the GEM file selector so you can enter a filename for your data. While the de­
fault Autodialer entries are saved in the STALKER.INF file, this allows you to have un­
limited additional Autodialer files. Use Save Configuration to make the current 
autodialer settings load automatically. 

Finally, the exit buttons are at the bottom left of the box. The Dial button exits the 
box and begins dialing selected entries. The OK burton exits the box and keeps any 
changes that you have made (though if you want to save them when you shut off the 
computer, select [Aiternate][G] to save rhe default configuration file). The Cancel bur­
ton exits rhe dialog box and ignores any changes made. 
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7.6.2. Dial Selected Entries... [Shift][Alt][A] 

When you display the Autodialer Directory 
dialog box, you can select entries to be dialed by 
left-clicking on the box to the immediate left of 
each dialer entry. 

When you choose chis menu option, selected 
entries will be dialed, one at a time, just as if you 
had displayed che Autodialer Directory dialog box 
and exited with the Dial button. 

7.6.3. Hang Up Phone Line... [Alt][H] 

This option hangs up the phone line, using the 
method specified in the Modem Settings dialog box. 
This option also causes the communications/trans­
fer/terminal settings to revert to their default values. 

The default values are the settings that were in 
effect at boot time, or at the time of the most recent 
Save Configuration command, if one has been issued 
since boor rime. 

7.6.4. Hang-up then Dial Next 
[Shift] [Alt] [H] 

This option hangs up, chen continues to dial 
selected entries in the list, starting with the next one 
in the sequence, until one answers. The effect is the 
same as selecting [Aiternate][H] followed by a 
[Shift][Atlernate][A]. 

Hang-up phone line OOH 
Hang-up then dial next ~lH 
Reset $N tlotk "~+:$ 

GEnie [+l! 
Cor~puServe [+l2 
Hike C's Super BBS [+ll 
«Uninstalled group» !+!4 
«Uninstalled group» :+:5 
«Uninstalled group» :+:6 
«Uninstalled group» :+:7 
«Uninstalled group» :+:8 
«Uninstalled group» :+:9 
<< Uninstalled rou •> :+:e 

Hang-up then dial next ~~H 
Reset $/0 tlotk "~+:$ 

GEnie Wl 
Cor~puServe W2 
Hike C's Super BBS Wl 
«Uninstalled group» ~• 
«Unlnstalled group» ~5 
«Uninstalled group» ~6 
«Uninstalled group» ~7 
<< Uninstalled group•> :+:B 
<< Uninstalled group•> :+:5 
«Uninstall ed rou » ~B 

6Enie Wl 
Cor~puServe W2 
Hike C's Super BBS 003 
<<Uninstalled group•> :+:4 
<<Un installed group•> :+:5 
<<Un Installed groUP•> :+:6 
<<Uninstalled group•> :+:7 
<<Uninstalled groUP•> :+:B 
«Uninstalled group» ~5 
«Uninstalled rou » ~8 
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7.6.5. Reset $/Time Clock [Control] [Shift] [Alt] [$] 

T his option will reset the connect time/dollar clock to zero. 

7.6.6. Dialing Groups [Alt][O] through [Alt][9] 

Note: Use numbers on main keyboard. 

If you entered a number fro m 0-9 into the 
Menu# fie ld of the Autodial Directory box, that enrry 
will be displayed in the corresponding fi eld (0-9) of 
the Dial d rop-down menu, and you can dial tha t 
enrry by choosing it fro m the menu. If you had 
more than one enrry with the same number, the text 
displayed in the menu wi ll be the name of the fi rst 
dialer en try with that number, and the en cries will be 
dialed in order unr il one answers. 

Autodialer direttory,., WR 
Dial seletted entries ~lR 
Hang-up phone line WH 
Hang-up then dial next «~H 
Reset $/0 c.1oc.k "~·:$ 

'' 
<<U n i nsta 11 ed group>> ~ :•:4 
«Un insta11ed group» ~5 
<<Un installed groUP>> :•:6 
«Uninsta11ed group» ~7 
«Uninsta11ed group» ~B 
«Uninsta11ed group» ~9 
«Uninstalled rou » ~8 

7.7. BackTALK Drop-Down Menu 

7.7.1. Run BackTALK Script [Alt][Enter] 

W hen you choose this option , you will see 
the GEM fil e selector. C hoose a BackTALK 
script to execute. T he default directory shown 
wi ll be the one specified in the Preference Set­
tings dial og box. 
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7.7.2. Change Menu Entries... [Alt][.] 

Note: Use the period on the numeric keypad. 

This option displays a dialog box which en­
ables you ro enter up to I 0 Back TALK scripts 
ro be displayed in the BackTALK drop-down 
menu. For each entry, enter the filename and 
the name you would like displayed in the menu. 
Back TALK files must be located in the directory 
specified in the Preference Settings dialog box. 
Clicking on the Filename field will display the 
GEM file selector. 

Drop-Down Menus and Dialog Boxes 

Run BatkTALK- stript,,. :~Ent 

~~~~- :~--------------------~~ 
Chetk 6Enie Hail ~~p1 
Call Mike c•s Super BBS ~~p2 
«Un i nstall~d script» ~Kpl 
«Uninstall~ d stript» ~Kp4 
<<Un install~d stript>> :+:Kp5 
«Uninsta ll~d stript» ~Kp6 
«Uninstall~d stript» ~Kp7 
«Uninstall~ d stript» AKpB 
«Uninstall~d stript» ~Kp~ 
<<Uninstall~d stript>> :+:Kp8 

Installed BackTALK~ Script Settings 

Title In BackTALK Henu 

Alt-KeyPad-1 
Alt-KeyPad-2 
Alt-KeyPad-3 
Alt-KeyPad-4 
A It-KeyPad-S 
Alt-KeyPad-6 
Alt-KeyPad-7 
Alt-KeyPad-8 
A It-KeyPad-' 
Alt-KeyPad-0 

6ENIE~--.BTK Check 6Enie Hail ________ _ 
HCBBS ___ . BTK Call Hike C's Super BBS __ ________ ,BTK 
________ ,BTK 
--------·BTK ________ ,BTK 
________ ,BTK 
________ ,BTK 
________ ,BTK 
________ ,BTK 

THe: .aTK ~lliU: S:HOUlO 81£ ~ltE.SIENT JN THE SCRI~T 

DJIItKCTCNt:V S,.ECIFIED IN THE 'l"lti:I"'IERENCE~ SI:TT INGS 

OK Cancel 

7.7.3. Scripts [Alt][O] through [Alt][9] 

Note: Numbers on the keypad only. Can also use [Control] instead of[Ait]. 

After you have specified entries using the 
Change Menu Entries dialog box, you can ex­
ecute a BackTALK script by selecting it from 
this section of the menu. Uninstalled entries 
will be grayed out and cannot be selected. 

Run BatkTALK- stript... ~lEnt 
Change "enu entries,,, ~~p. 

Chetk 6Enie Hail ~~p1 
-N:II I' 11 

«Uninstall~d stript» 
«Un install~d script» 
«Uninstall~d script» 
«Uninstall~d stript» 
«Un install~d script» 
«Uninstall~d script» 
«Uninstall~d script» 
<<Uninstall~d script>> 
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7 .a. Help Menu 
The two entries in the Help menu display dialog boxes 

with information on basic keyboard and mouse commands. 
Left-click or press any key to exit the Help boxes. 
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8. Using STeno with 
STalker 

8.1 ~ Keeping Multiple Copies of STalker and 
STeno in Memory 

Some Acari computers, such as the TT, have multiple serial pores. Even if you only 
have one serial pore, you may own a product such as Double-Click Software's DC-Port, 
which gives your computer extra pores. If you have these extra pores, you can connect 
more than one modem ro your computer and connect to more than one host system at 
the same time. STalker is only designed to talk to one pore at a time. Fortunately, as 
STalker is also designed ro run at the same rime as other programs, there is a simple 
solution. If you have more than one pore, you can keep more than one copy of STalker 
in memory, each one connected to a different pore! 

To do this, simply make copies of the STalker desk accessory file (STALKER.ACC) 
keeping the copies in the same directory. You can use any name you want as long as 
you keep the ".ACC" extension, but it is best to use STALKER1.ACC, 
STALKER2.ACC, etc. since each copy will then use STALKER1 .1NF, STALKER2.1NF, 
etc. , and will label itself with a name and number, so you can tell which accessory is 
which. If you use other names, they all will load STALKER.INF, and you will have ro 
manually rename each accessory as explained in the next paragraph. When you reboot 
(reset) your computer, you will see the STalker entry on the desk menu as many rimes as 
you made copies of the file. (Remember, without special software there is a limit of 6 
desk accessories.) 

Open each copy of STalker and use the Communication Port dialog box to set each 
copy to a different pore. Then, open the Preference Settings dialog box and use the Win­
dow/ACC Prefix text field to give each copy of STalker a unique name. This name will 
be displayed in the Desk (or Atari "Fuji" Logo) menu and at the top of the window. 
(This is not necessary if you numbered your accessory's filenames, as the windows will 
automatically be numbered.) Finally, use Save Configuration to save each copy's setup 
in a unique file . If you do not use Save Configuration As ... , but you did number your 
accessory files, rhe name of the setup file will correspond to the name of the ".ACC" file; 
STALKER.ACC will save to STALKER.INF, STALKER1 .ACC will save ro 
STALKER1 .1NF, and so on). 
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As STalker can be run as a stand-alone program, if you have no ocher desk accesso­
ries, you can have as many as seven copies of STalker running at once - six accessories 
plus che stand-alone program copy. 

STalker also communicates with STeno, Gribnif Software's desk accessory text edi­
tor. If you are running mulciple copies of STalker, you may also wane independent co­
pies of STeno. Install the copies of STeno as you did for STalker, keeping in mind the 
six accessory limit. Then , when you set up each copy of STalker, change the text field in 
che Preference Settings dialog box where ic says STeno Name to che filename of one of 
che copies of STeno. Make sure char each copy of STalker communicates with an indi­
vidual copy of STeno. Finally, activate each copy of ST eno and choose Preferences ... 
from the Options menu. Enter che filename of che copy of STalker you want this copy 
ofSTeno to communicate with into the field labeled STalker to communicate with and 
change the field labeled Window/ACC Title Prefix to a unique name (this field is STe­
no's equivalent of STalker's Window/ACC Prefix field in the Preference Settings dialog 
box). 

8.1.1. Example 

If all this seems confusing, here is an example. Suppose you have an Atari TT030 
with two modems, each attached to a serial port. You want to have two copies of the 
desk accessory version of STalker and two copies of the desk accessory version of STeno 
in memory. The first STalker should talk to modem#!, while the second talks to mo­
dem #2. Each copy of STalker should have an independent copy of STeno communi­
cating with it. 

First, open a window to the directory where your desk accessory files are located. 
Install a copy of STalker and a copy of STeno the usual way. Next, as you can only 
have a maximum of six accessories, you may need to make room for two additional ac­
cessories by changing the extension of existing accessories from ".ACC" to ".ACX". 

Next, drag the STALKER.ACC file within the directory window and drop it (not 
into a folder, however). You will see a "Name Conflict During Copy" message. Change 
the STALKER.ACC text field to STALKER2.ACC and exit the box with the COPY but­
ton. Do the same thing with the STENO.ACC file, and change the name to 
STEN02.ACC. After you are done, reset your computer. 

If you look under the Desk menu, you will notice that there are now two copies 
each of STalker and STeno. Open up the topmost copy of STalker, open the Commu­
nication Port dialog box, and choose the first modem port. Exit the dialog box and close 
this copy of STalker. 

Next, open up the copy of STalker which is the bottommost on the Desk menu. 
Open up the Communication Port dialog box and choose the second modem port. Exit 
the dialog box. Then, open the Preference Settings dialog box. Change the text field 
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labeled Window/ACC Prefix to "STalker 2:" (do not type the quotes). Change the field 
labeled STeno Name to "STEN02". Exit the dialog box. 

Now, open the copy of STeno bottommost on the Desk menu. Choose Prefer­
ences ... from the Options menu. Enter "STALKER2" into the field labeled STalker to 
communicate with and change the field Window/ACC Title Prefix to "STeno 2:". 

Unfortunately, the order in which the various programs show up on the desk 
menu is not necessarily the order in which they are stored on the disk. Therefore, you 
cannot assume that STalker and ST eno are communicating with each other and 
STalker2 and STeno2 are communicating. It is also possible that you may have STalker 
talking to STeno2 , and STalker2 talking to STeno. Therefore, the final step is to open 
one of the two copies of ST eno, and choose Arrange STalker & STeno Windows from the 
STalker menu. See which copy of STalker and which copy of STeno arrange them­
selves on the screen . This shows you which copy of STalker is connected to which copy 
of STeno. If you have it set up as STalker-STeno2/STalker2-STeno, you may wish to 
adjust the Window/ACC Prefix entries in STalker, and the Window/ACC Title Prefix 
field in STeno so that the copys' titles match properly. 

8.2. Using STeno as a Type-ahead Buffer for 
STalker 

A type-ahead buffer is an area of memory into which you can enter and edit text be­
fore you send it to your modem. STeno is designed with special features that make it 
perfect for use as a type-ahead buffer for STalker. 

To use STeno as a type-ahead buffer, open the STeno window and select Type­
Ahead Mode from the STalker drop-down menu in STeno. You will see a special sym­
bol composed of three horizontal lines displayed at the left margin of the STeno win­
dow. This symbol indicates that type-ahead mode is turned on. 

While in this mode, as soon as you press [Return] , the current line of text in the 
STeno window will be sent to STalker, which will transmit it over the modem. Before 
you press [Return], you can edit the line using the left and right arrow keys , the [Delete] 
key, and the [Backspace] key. This enables you to make sure your line of text is en­
tered correctly before you actually transmit anything. If you type more than one line, 
STeno will word-wrap normally. When you press [Return], everything you have entered 
will be transmitted by STalker. The STeno menu entry Send a <CR> after each Line 
controls whether or not word-wrapped lines are sent with Carriage Returns after them. 
If the option is on, CRs are sent. If not, STeno sends a single space between each line, 
making the input look like one big line (great for online conferences!). 

When you turn type-ahead mode off by selecting Type-Ahead Mode a second time, 
the text you sent to STalker is not erased. It remains in the STeno window and it may 
be edited or saved just like any other text in the window. 
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. If you wish to send pre-existing text to STalker, or type without using type-ahead 
mode and then transmit the text, enter your text into STeno normally or load a file from 
disk. Then, define a block of the text you want to send to STalker (see your STeno 
manual for details). Finally, choose Transmit Line/Selection from the STalker menu in 
STeno. The block will be sent to STalker, which will transmit it over the modem . 
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9. Using STalker 3 with 
NeoDesk 

When running STalker as a desk accessory, you can install it as a NeoDesk Accessory. 
This gives STalker some extra capabilities when used with Gribnif Software's Neodesk 3 
and NeoDesk 4 desktops. 

To install STalker 3 as a NeoDesk Accessory, enter the STalker filename in the Acces­
sories ... dialog box in the Set Preferences ... menu entry under the NeoDesk Options 
drop-down menu. 

Once you have installed STalker 3 as a NeoDesk Accessory, you can place the 
STALKER.ACC icon directly on the NeoDesk desktop and select Save Configuration ... 
to save it permanently. 

From this point on, you can do the followin-g from the NeoOesk desktop: 

I. You can open the STalker 3 accessory by double-clicking on the STALKER.ACC 
desktop icon. 

2. By assigning a unique desktop icon letter to the STALKER.ACC icon, you can open 
rhe STalker accessory directly from the keyboard. 

3. You can have STalker automatically execute a Back TALK script by dragging the 
script icon to the STalker icon and dropping it. 

4. NeoDesk windows will be updated automatically when STalker creates a new file 
during download or when saving a block of text to disk. 
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10. Technical Information 

1 0 .1. Shutdown 
Shutdown is a special feature acrivared by doing a [Controi][Shift][Aiternate] key 

combination rogerher wirh a lefr-click on rhe window close box. Doing rhis, rhen con­
firming ir ar rhe alerr box, will cause STalker ro free all of irs allocated memory and oth­
er system resources, rhen shur down. lr is inrended for use just before a change of 
resolutions, ro prevent loss of system RAM. This is more common in older TOS 
systems. 

1 0.2. The STalker Clipboard 
The STalker clipboard is actually a hidden rexr file called SCRAP.TXT which is 

saved in rhe clipboard directory of rhe drive specified in rhe Preferences ... menu entry. 
This file is created whenever you use any of rhe clipboard options. Since STeno uses the 
same filename for irs clipboard, any STalker clipboard usage ove1writes the STeno clip­
board, and vice-versa. Thus, you can transfer dara through the clipboard between 
STalker, STeno, and any other program using the same clipboard sysrem. 

STalker can use two different methods to write to the clipboard. In the "old" 
method, STalker writes a hidden SCRAP.TXT file to the drive specified in the Prefer­
ences dialog box. The "new" method is selected by using a Clipboard Drive of "Z" ; rhe 
path is not set directly by STalker, but ir is inquired from the operation system. This 
allows all programs which are aware of the new standard ro use rhe same location for 
clipboard files . 

1 0.3. Y /Z Modem Information 
In YModem and ZModem, rhe sender transmits the file name, and optionally rhe 

file size, modification dare/rime, rhe file "mode" (permissions ere. a Ia UNIX) and a seri­
al number. Most YModem implementations send rhe file size, some send more; iris up 
ro th~ receiving program to decide whar to do with the data. STalker sends the size, 
dare, and mode. The mode will be 0 unless rhe file is marked as 'read only' , in which 
case rhe mode will be octal 444 (Unix mode for a read-only file). 

As per rhe Y/ZModem specification, fi lenames are convened to lowercase before 
transmitting, and the slash character (/) is used to delimit directories. If the file being 
sent happens ro contain a "/" in irs name, STalker changes ir to an underscore 
character. 
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1 0.4. Timestamps in Y /ZModem 
The modification time is sent as the number of seconds since January I, 1970 Uni­

versal Coordinated Time (GMT). Since the Atari operating system has no concept of 
time zone, STalker allows the user to enter the system's "offset" from GMT in minutes. 
This amount affects the conversion of time values between GMT and Atari format. A 
value of zero means that the value will be converted but not altered. Non-zero values 
are subtracted in the Atari-to-GMT conversion, and added in the GMT to Atari conver­
sion. If you transfer files with a system that handles time zones correctly (like a Unix 
host), it is a good idea to set your GMT offset. If you transfer files with systems that do 
not handle time zones (such as most BBS systems), then you can leave it set to 0. There 
is no sure way to tell what any other system is doing other than to look at the time­
stamps you get on received files and see if they are what you expected. 

1 0 .5 . File Transfer Efficiency 
The upload and download status boxes display an "efficiency" rating showing the 

efficiency of your transfer speed, where I 00% is the theoretical maximum speed (baud 
rate divided by I 0). This efficiency is dependent on the protocol being used as well as 
the speed of the sending and receiving computers. The protocol affects efficiency since 
extra characters may be transmitted to perform error checking, etc. Protocols like XMo­
dem that require the sender to stop and wait for the reciever to acknowledge each block 
reduce the efficiency since there are small periods of "dead time" where nothing is hap­
pening. STalker calculates efficiency by looking at how many bytes of actual data have 
been transmitted in the elapsed time, not including additional bytes for error checking, 
etc. 

While ZModem is one of the most efficient protocols and you should try to use it 
as often as possible, there are cases where it can become bogged down (mostly due to its 
complex error correcting protocols). This usually happens if you are dealing with a very 
noisy phone line. Under this situation, you might want to try YModem, which is able 
to more efficiently cope with very noisy phone lines. 

1 0.6. Capture Mode 
Capture Mode lets you send incoming text directly to STeno. If you do not have 

STeno, the Receive Text File command is a good alternative. There are differences be­
tween the two methods, however, as follows: 

I. Capture Mode requires STeno. 

2. Capture Mode filters out control characters and escape sequences by sending lines of 
text only when the cursor moves to a new line via a line feed or formfeed. If the 
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cursor moves off the line due to a cursor positioning command, the line will not be 
sent to STeno. 

3. Receive Text File copies every character received from the host computer, except for 
ASCII Null, to the disk file. Control and escape sequences are not filtered out. 
This makes it an effective way to capture a session along with the control sequences 
to be replayed later or used to test other terminal emulators. 

4. Receive Text File uses the file transfer buffer, so you cannot perform another file 
transfer while iris active. You can, however, perform a file transfer while Capture 
Mode is active . 

5. Receive Text File is more efficient than Capture Mode, since it does nor require 
communiction with STeno, which requires a good amount of system overhead. 

1 0. 7 . Reset Communication Port 
The Reset Communication Port command in the Options menu has the following 

effects: 

I. It resets rhe XON/XOFF flag so that the Atari can transmit. 

2. The video attributes (bold, underline, etc) are reset. Color is not changed, 
however. 

3. Any escape sequence currently being processed is aborted. 

4. The VTI 00/PC-ANSI character mappings are reset to their default values. 

5. The VTI 00/PC-ANSI scrolling region is reset to the entire virtual screen. 

6 . Any characters waiting in the port buffer are removed. 

1 0.8. Autodialing Routine 
The following is a detailed explanation of the way in which STalker's Autodialer 

dials. 

I. STalker finds the first selected entry in the list and switches the communication 
port settings to rhe ones for that entry. 

2. STalker sends the modem in it string, and then pauses for half a second to let the 
modem "digest" it. 

Then, for each selected entry, STalker will: 

I. Switch to the communication settings for that entry. 
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2. Send the prefix, then the number, then the suffix string to the modem. If the prefix 
and suffix strings are empty, you will be instructed to dial the phone manually. 

3. Pause for 1/4 second to let the modem "digest" the command. 

4. STalker will then wait up to NN seconds for a connection, where NN is the number 
in the Autodialer dialog and 0 means to wait forever. The following algorithm is 
used. Nore rhat the riming begins after STalker sends the command to the modem. 
It is at this point that the modem begins to dial. 

5. If DCD is enabled and carrier becomes active, dialing was successful. Go to step 
10. 

6. If DCD is enabled and rhe modem sends some text, STalker assumes ir to be a 
srarus message such as "BUSY" . STalker will read rhe response from the modem 
and display ir in rhe terminal window. There will then be a 112 second pause to 

give rhe modem rime to ser DCD, rhen STalker will examine DCD. If iris acrive, 
dialing was successful; go to srep I 0. Otherwise, dialing was not successful; go to 

srep 15. 

7. If DCD is nor enabled, STalker waits for one of rhe 6 connect/failure strings robe 
received. If a connect string is received, dialing was successful ; go ro step I 0. If a 
failure string was received, dialing was nor successful; go to step 15. 

8. If dialing was successful , rhe special rune is played and rhe window title is updated 
accordingly. 

9. The file transfer and terminal settings for rhe entry are acrivared. 

10. The Logon Prompt/Response strings, if any, are used. 

11. The Cash/Time Clock is reset and turned on. 

12. The Back TALK Script To Be Executed, if any, is executed. 

13. If dialing was nor successful, STalker sends a Carriage Rerum to rhe modem and 
then pauses for 1/4 second. This will cause Hayes-compatible modems to aborr rhe 
current command. 

14. If DCD is enabled and carrier was nor present when dialing started, STalker will 
drop the DTR signal (assuming DTR is enabled and available on the current porr) . 
This will ger mosr modems to abort dialing and return to command state, and is 
necessary for non Hayes-compatible modems that are nor affected by step 15. 

15. STalker will then pause for 3/4 second and rhen return to step 3 for rhe next 
selected entry. 

Note: If you are dialing a long distance number, particularly with pulse dialing, it may 
take a long rime for the dialing to occur, so you may need to increase the rimeour 
value (wait NN seconds for connection in the Autodialer dialog box). If STalker 
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aborts the dialing attempt before the modem can respond, you can usually 
assume that the timeout value was too small. 

1 0.9. ASCII Null Character 
Typing [Control][2] will transmit an ASCII Null character. 

1 0.1 0. Using Multi Desk 
While STalker will work inside the Mu!tiDesk program from CodeHead software, 

we recommend that if you plan to use STalker with STeno or as a NeoDesk Accessory 
you keep STalker outside of MultiDesk. This is because when STalker is used in this 
way it relies heavily on the GEM "pipeline communications" which do not always work 
reliably from inside MulriDesk. Keeping STalker outside MultiDesk will also help pre­
vent problems if the STalker accessory is directly invoked by the Invoke STalker com­
mand inside STeno or by the NeoDesk desktop. This is not due to a bug in Multidesk, 
but to a limitation in the GEM environment which only allows one MultiDesk accesso­
ry use the GEM "pipeline" at a rime. 

1 0.11. Using the Fast load Option 
You should nor use the TOS 1.4 or higher FastLoad option with STalker when it is 

run as an accessory. Using this option can cause unexpected behavior, including system 
crashes. It is safe to use the FastLoad option when running STalker as a program. 

1 0.12. Using PinHead 
If you use the PinHead shareware program from CodeHead Software, you MUST 

make sure that you have a PINHEAD.DAT file in the root directory of your boot disk. 
Inside this file you should have entered STALKER.ACC (or whatever other file name 
you are using). This is because when STalker runs as a desk accessory it requires that irs 
memory be cleared before execution. For more information, please consult the PinHead 
documentation. Nor entering the STalker name in rhe PINHEAD.DAT file is likely to 
cause unexpected system crashes. 

1 0.13. Using GDOS 
In the GDOS fo lder on your STalker disk, you will find GDOS.PRG and several 

PC style GDOS fonts . IBM06.FNT is a 6 point, 8x8 pixel wide font. IBM11 .FNT and 
IBM12.FNT are II and 12 point versions that have 8 x 14 and 8 x 16 pixel dimesions, 
respectively. In addition , there is a PC-ANSI 9 point font, which lets you have 80 col­
umns displayed in a regular screen size. 
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In addition to the supplied fonts, you can use others. STalker can recognize any 
monospaced {non-proporrionsal) GDOS font in which all regular 256 characters are 
present. The Typewriter font is an example. A font missing some of the control charac­
ters will be ignored. 

However, you should keep in mind that GDOS fonts can slow down the text dis­
play in older TOS systems . 

To use GDOS fonts, you must have GDOS.PRG, FONTGDOS.PRG, NVDI.PRG, 
or a compatible program in the AUTO folder of you boot disk. Then, you must add the 
fonts to your ASSIGN.SYS file, as follows: 

10.13.1. Sample ASSIGN.SYS File 

path= c:\GDOS (or whatever directory your fonts are in) 
Olp screen.sys ; DEFAULT 

... other fonts you may have 
02p screen.sys ; low res 

... any low res screen fonts here 
03p screen.sys ; medium res 
IBM06.FNT 
IBMll.FNT 
IBM12.FNT 
PC-ANSI.FNT 

.. . other fonts you may have 
04p screen.sys ; high res 
IBM06.FNT 
IBMll. FNT 
IBM12.FNT 
PC-ANSI.FNT 

... other fonts you may have 

.. the rest of your ASSIGN.SYS file 

75 



STalker 3 

11. Index 
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ASSIGN.SYS, 75 
Auro execure Scripr, 58 
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Binary uploads, 30 
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Block functions, 20 
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c 
Caprure Mode, 54, 71 
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Copy, 41 
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Copyright Notice, I 
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D 
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DB-25 porr, 23 
DCD, 73 
Defecrive Disks, 3 
Desk accessories, 33 
Desk menu, 33 
Dial menu, 57 
Dialing, 27, 61 
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Disabling STalker, 55 
Disclaimer Norice, 3 
Download binary file ... , 37 
Download directory, 53 
Downloading, 28 
DTR, 51,73 
Duplex, 25 

E 
Echo, 55 
Edir menu, 41 

F 
FasrLoad oprion, 74 
Favour concurrency, 54 
File menu, 34 
File rransfer, 28 
File rransfer serrings ... , 43 
Flow conrrol, 26 
Full duplex, 25 
Full size burron, 17 
Funcrion key scrrings ... , 49 

G 
GDOS, 48,74 
GEnie, 6 
GMT, 53 
Gribnif Software, I, 5 

H 
Half duplex, 25 
Hanging up, 28, 61 
Hayes, 24 
Help menu, 64 
High speed modems, 24 
Hosr prompt, 59 
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R 
Installing ST alkcr READ_ME.NOW, 5. 32, 44 

as a Desk Accessory, 8 Receive rexr file ... , 35 
as a GEM Program, 9 REGISTER.PRG, 7 

Imerner, 6 Registering, 7 
REMOTE.BTK, 39 

K Remote (mini-BBS) mode ... , 38 

Keyboard shortcuts, 15 Reming, 2 
Reser communications port, 55. 72 

L Resize gadget, 18 

Licensing Agreemem, I RS-232, 51 
RTS/CTS, 26 

M Running 

Master disk, 7 
as a Desk Accessory, II 
as a GEM Program, II 

Menu bar, 14 as a NeoDesk Accessory, II 
as a Desk Accessory, 15 
as a GEM Program, 14 5 

Modem Senings ... , 50 
Save configuration, 34 Modems, 23 

MuhiDesk, 74 Save ro disk, 22 
SCRAP.TXT, 70 

N Script directory, 53 
Scroll bars, 19 

NeoDesk, 69 Selecting a block, 21 
NeoDesk Accessory, 69 Send rexr file ... , 35 
Northampton, 5 Sening X/Y/ZModem, 45 
Null modem cable, 23, 74 Senings menu, 42 

0 
Shadow access ... , 40 
Shurdown, 70 

Open configuration file ... , 34 Sofrware piracy, I 
Operating STalker, 12 Sounds, 54 
Options menu, 54 ST ALKER.ACC, 8 

p 
STALKER.INF, 34 
STALKER.PRG, 8 

Parity, 26 ST ALKER.RSC, 8 
Paste, 4 1 STalker info ... , 33 
Pasre ro STeno, 22 Status line, 16 
PC-ANSI, 26, 47 STeno, 37, 53, 65 
PinHead, 74 Stop bits, 26 
Preface, I Support, 5 
Preference senings ... , 52 

T Print, 22, 56 
Problems, 5 Terminal emulation, 26 
Program overview, 4 Terminal senings, 27 

Q 
Terminal senings ... , 47 
Text (ASCII) Files, 28 

Quit, 40 Text file download, 29 
Text file upload, 29 
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Text settings, 43 
Time stamps. 71 
Tide bar, 16 
Transfer efficiency, 71 
Transmit, 22 
Type-ahead mode, 67 

u 
UNIX, 70 
Upgrading STalker, 3 
Upload binary file ... , 36 
Uploading, 28 

v 
VAX sysrems, 4 7 
Virrual screen, 19, 20 
VT-100, 26,47 
VT-52, 26, 47 

w 
Window conrrols, 15 
Window sryle, 57 
Word lengrh , 25 

X 
XModem, 29, 31 
XON/XOFF, 26 

y 
YModem, 29, 31 

z 
ZModem, 29, 31 
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